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Storybook Weaver: World of Make-Believe

Storybook Weaver: World of Make-Believe is a versatile writing tool | Welcome to
for the Apple IIGS computer, designed to engage students in the .
writing process. Storybook Weaver: World of Make-Believe allows ?vtgmbg: k Weaver:

students to author a story or storybook. Through writing, students
intertwine the language arts—reading, writing, speaking, listening,
and thinking—as they weave their ideas into the pictures and stories
they create. Storybook Weaver: World of Make-Believe draws on
the elements of folk literature, allowing students to explore folklore
from various cultures. Since folktales and fairy tales offer a route to
fantasy and make-believe, this theme is reinforced through the use of
colorful scenery and objects available for creating pictures to
accompany student stories.

Make-Believe!

Storybook Weaver: World of Make-Believe allows students to create
their tapestry of ideas, words, and pictures as they design the fabric of
their stories. By allowing students to move easily between pictures
and story text, Storybook Weaver: World of Make-Believe provides
flexibility in the writing process. While the purposes for writing vary
widely, Storybook Weaver: World of Make-Believe can be used in
any forum in which students are encouraged to write. Storybook
Weaver: World of Make-Believe comes complete with help screens
and a section that provides a step-by-step look at the product.

Students can create pages that include picture and text or text only.
Storybook Weaver: World of Make-Believe includes a variety of
foreground and background scenes and colors that can be combined
to create a setting that invites students to write. Students can select
from eight different categories of objects to include in their picture.
All objects can be previewed before being placed in a picture.
Objects can be manipulated by moving, enlarging, reducing, flipping,
and coloring the images. The pages the students have created can
then be combined to create storybooks that they can print.

Storybook Weaver: World of Make-Believe has many unique
features as well. Scenery can be created in two parts. With separate
foreground and background choices, students can interchange parts to
create their own scene. The “Day” and “Night” buttons allow
students to further customize their story setting. A “Spell” button
encourages students to use their rich oral vocabulary in their writing.
And selecting “Choose a story to read” provides an opportunity to
“page through” stories written by other authors.

By weaving together the language arts, Storybook Weaver: World of
Make-Believe provides students with an exciting opportunity to
express themselves in writing.
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Manual

¥2

There are seven sections in this manual. The first section, “The
Product at a Glance,” briefly describes Storybook Weaver: World of
Make-Believe and details the computer rationale behind its
development, the required equipment, the Apple IIGS desktop, and
how files can be stored.

The second section, “Getting Started with Storybook Weaver: World
of Make-Believe,” takes you through a series of steps to help you get
started. You will see an overview of the different cursor types used
in the product, the various means of clicking with the mouse, and the
Help screens that are available.

The third section, “A Step-by-Step Look at Storybook Weaver:
World of Make-Believe,” introduces you to the product and many of
its functions. As you go through this section, you will learn how to
create a story page. You might want to use this section to introduce
the product to your students.

The fourth section, “Exploring the Features of Storybook Weaver:
World of Make-Believe” covers each menu and menu item in
succession. Each menu is discussed in detail, and many tips and
techniques regarding each menu item are given. You will also find a
complete discussion of each dialog box associated with a menu item.
If you need specific information about a menu item or dialog box,
you will find it in this section.

The fifth section, “Questions About Storybook Weaver: World of
Make-Believe,” presents specific questions teachers have asked and
MECC’s attempt to answer them as thoroughly as possible. Before
you call MECC’s Help Line, check this section to see whether your
question is answered here.

The sixth section, “Use in an Instructional Setting,” gives an
overview of the writing process and provides suggestions for
incorporating Storybook Weaver: World of Make-Believe into the
curriculum. This section also offers a number of suggestions for
using writing activities that can be completed using the product.

The final section, “Appendices,” contains a listing of the scenery and
object selections that are available, a bibliography, and a glossary of
terms.




In addition to the descriptive section headings used throughout this
manual, the outside margins contain special symbols designed to be
recognizable at first glance. These icons will alert you to important
information!

The hand icon warns of potentially “hazardous” activities that, if
performed incorrectly, could result in frustration and wasted effort.

The reminder icon marks tips and hints that apply to the basic
operations of Storybook Weaver: World of Make-Believe.

The eyeglasses icon outlines creative options that you may add to
your Storybook Weaver: World of Make-Believe document or refers
you to additional sources of information.

Storybook Weaver: World of Make-Believe is an open-ended writing
tool which actively engages students in the writing process. Students
can author and illustrate their own stories using a simple word
processor and a variety of graphic features. Mixing and matching
from a selection of foreground and background colors and scenes,
students create a variety of settings. To illustrate their storyline,
students select from a collection of over 500 graphic objects that they
can manipulate by changing color, size, and orientation. Storybook
Weaver: World of Make-Believe has the flexibility to accommodate
the wide range of reading and writing skills of elementary students.
For some, Storybook Weaver: World of Make-Believe will provide
an introduction to writing while for others it will provide an enriching
environment in which they can exercise their existing skill base.

Description
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Computer Rationale | Based on the thematic approach of Storybook Weaver: World of
Make-Believe, students are encouraged to use their imaginations to
explore a world of make-believe. Storybook Weaver: World of
Make-Believe reinforces vocabulary development, sequencing,
classification, and writing with a purpose.

Storybook Weaver: World of Make-Believe was created to:

» allow students to explore the writing process using a
simple word processor to author a story;

 allow students to create illustrations that visually depict their
storyline;

 allow students to author a story to accompany their
illustration;

» give students opportunities for purposeful writing;

e provide students opportunities to share their writing with
an audience while others read their stories;

 foster thinking skills as students work through the writing

process;
* utilize students’ inherent creativity to write and illustrate
a story;
» enhance students sight-word vocabulary by associating a
word with its related picture;
» develop sequencing skills as students author a story using
the writing process.
Equipment To use Storybook Weaver: World of Make-Believe, you need the
Required following equipment:

e an Apple IIGS computer, a mouse, and at least 1 megabyte of
memory;

e two 3.5" 800K disk drives are required (a 5.25" drive is
optional for saving stories);




» a color monitor (a monochrome monitor can be used, but
without full benefit of the capabilities of the product); and

e an Apple printer (any ImageWriter or LaserWriter) or a
compatible Epson® printer.

Before using Storybook Weaver: World of Make-Believe, you should
be familiar with the Apple IIGS desktop, clicking with the mouse,
selecting and dragging objects, dialog boxes, and file selection
menus. Refer to your Apple IIGS Owner’s Guide for more
information on these subjects.

Storybook Weaver: World of Make-Believe comes on two 3.5" disks,
but files can be saved to 3.5" or 5.25" disks. Storybook Weaver:
World of Make-Believe files saved on disk require different amounts
of storage space. This size depends on the make up of the document:
the number of pages, the number of graphics, and the amount of text.

Writing is a powerful instrument of thought. As students are engaged
in the writing process, they gain insights about themselves and the
world while they communicate those insights to others. Students
learn to write by writing. It is our hope that Storybook Weaver:
World of Make-Believe will become an integral part of your
classroom writing environment.

Storybook Weaver: World of Make-Believe

Apple liGs
Desktop

Storybook Weaver:
World of
Make-Believe Disk
Information



Storybook Weaver: World of Make- Belleve

-~



Storybook Weaver: World of Make-Believe

R 22 LA SRR . 22

Follow these steps to begin using Storybook Weaver: World of Starting Up:
Make-Believe: Launching the
Product

Step1:  Insert the Storybook Weaver: World of Make-Believe
System disk into Drive One and the Storybook Weaver:
World of Make-Believe Program disk into Drive Two.

Step2: Tumn your Apple IIGS on and wait for the desktop to
appear. This takes approximately one minute.

Step 3:  If the Storybook Weaver: World of Make-Believe
Program disk window has not appeared on the screen, use
the mouse to click the Storybook Weaver: World of
Make-Believe Program disk icon to highlight it.

Step4:  Next, pull down the File menu and select Open. You can
also open the program disk by double-clicking on the StaruBook
Storybook Weaver: World of Make-Believe disk icon.

(The “Clicking with the Mouse” section, beginning on page 12, better
explains what “clicking” means and describes different methods of
using the mouse.)

In the picture below, the Storybook Weaver: World of Make-Believe

icon is one of several appearing on the desktop. The Storybook

Weaver: World of Make-Believe disk is “open” and, in the disk

window, you can see the Storybook Weaver: World of Make-Believe

program icon. You can “close” the disk by clicking on the Close box

in the upper-left comer of the disk’s title bar or by selecting Close

from the File menu.

o File Edit Vies Biz: Special izl
Sitens J20Kused |

W

. Starubook:

Hoke.Belirve
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— The system disk icon is closed. You can open it by double-clicking
s“m on it or by clicking the mouse on the icon once to select it and then

) selecting Open from the File menu. You can remove a disk from the
desktop by clicking on its icon once to select it and then selecting
Eject from the Disk menu.

The trash can appears in the bottom-right corner of the screen. Files
and folders can be “thrown away” by dragging them into the trash
Trash can. If you double-click on the trash can, or if you select the trash
can and then select Open from the File menu, you can “open” it to see
its contents. You can drag documents or folders out of the trash can
and back onto the desktop or onto a disk.

Discarded files or folders stay in the trash can until you select Empty
Trash from the Special menu, or until you start a program. Be careful
using the trash can! Emptying the trash can will permanently remove
files and folders from the disk. Once you do this, they are gone
forever.You will not get a prompt informing you that you are about to
delete files or folders when you empty the trash. If you attempt to put
certain locked files in the trash can, you will get the alert shown
below:

& The file/folder "PRODUCT.INFO" is locked
(or contains items that are locked).
Remove it anyway?

We advise you to cancel immediately. Never put a program icon or a
system folder in the trash can.

You can eject a disk by dragging its icon to the trash can. We
recommend that you use the standard menu method: Select the disk
you wish to eject by clicking on it once. Then select Eject from the
Disk menu.
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To launch the program from the desktop, you must:

Step 5:  Click on the Storybook Weaver: World of Make-Believe
icon to highlight it. Pull down the File menu and select
Open or double-click on the Storybook Weaver: World of
Make-Believe icon—the program will begin loading.

HRKE.BEL [EVE

The computer takes about a minute to open the program,
during which time the title screen appears:

Storgf)oo& chwer

World of Make—Believe
Version 1.0

by Charolyn Kapplinger.
Patricia Korn, and Jean Sharp

3490 Lexington Avenue
St. Paul, MN 55126-8097
C(612) 481-3500

Copyright MECC, 1991

Step 6:  You see the main menu options for Storybook Weaver:
World of Make-Believe. Each of these options will be
explained in detail in the “Step-by-Step Look at Storybook
Weaver: World of Make-Believe” section beginning on
page 15. At the top of the screen is the menu bar. These
menus contain options described in this section and in the
“Exploring the Features of Storybook Weaver: World of
Make-Believe” section beginning on page 45.
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The main menu of Storybook Weaver: World of Make-Believe
appears below.

Start a new story.

Choose a story to finish.

Choose a story to print.

Choose a story to read.

I would like to quit now.

Getting Help (3-?) If you have a question or run into any trouble with the program once
you have made a selection from the main menu, remember that Help
screens are always available by selecting Help... from the & menu.
The page numbers that appear in the on-line Help refer you to pages
in this manual that provide further explanation. To access the Help
screens, follow the steps listed below.

Step 1:  Pull down the  menu and select Help.

Step2: In the dialog box that appears, select the type of help you
would like from the list of available topics: Apple Menu,
Color Palette, Cursors, Edit Menu, File Menu, Goodies
Menu, Main Menu Options, Mouse Functions, Objects,
Page Features, Scenery, Text, Title Page, or Tool Palette.

Help Topics

Apple Menu Cpages U5-53) [}
Color Palette C(pages 41-42)
Cursors {pages 11-12)
Edit Menu Cpages 63-63)
File Menu Cpages 53-63)

Goodies Menu (pages 65-73)
Main Menu Options (pages 15-16)
Mouse Functions rages 12-133 |0

10
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It’s a good idea to read through the various sections of this manual.
If you are in doubt about a particular menu item, consult the
“Exploring the Features of Storybook Weaver: World of Make-
Believe” section, beginning on page 45, which details the functions
and options available with each menu item.

If you’ve used Apple IIGS programs before and are familiar with the | Different Types of
use of the mouse, you are already acquainted with the various types | Cursors
of cursors that appear throughout the product.

k The Selection Cursor

The selection cursor is used to perform most basic program
functions, including selecting menu items, clicking on the various
buttons on the tool or color palette, and selecting, moving, and
coloring objects in the picture window.

[Z] The Wait Cursor

The familiar wait cursor indicates that the program is in the process
of carrying out a command or some other function you have
implemented. Until it changes back to some other type of cursor,
you can’t execute another command.

I The I-beam Cursor

The I-beam or text cursor appears when you are in the story window
or entering text on the title page. This cursor allows you to click
anywhere in your story and editit. You can also highlight text by
dragging across a selection of text. As soon as you click the mouse,
the I-beam will disappear and the insertion point cursor will appear.

11
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I The Insertion Point Cursor

The insertion point appears at the current cursor location in text. The
insertion point flashes its position on the screen. This is the point at
which text is typed or inserted into the story document. The
insertion point is placed by clicking the mouse. The insertion point
remains at its location even after you pick up the mouse to move it.
It will remain at its location until the mouse is clicked at a new
location.

To use Storybook Weaver: World of Make-Believe, you need to be
familiar with the Apple IIGS desktop interface. Here is a quick look
at how the mouse works. If you need additional information, see
your Apple IIGS Owner’s Guide.

Various types of “clicking” actions with the mouse have different
effects with different items.

In Menus:
Hold down the mouse button—Pulls down a menu.

Move the mouse with the mouse button down—
Highlights menu items.

Release mouse button—Selects highlighted menu item.
On Graphic Objects:

Click—Selects a single object. All previously selected
objects are de-selected.

Shift-click—Selects or de-selects an object without
de-selecting any previously selected objects.

Click and Drag—Selects and moves an object. All
previously selected objects are de-selected.

Shift-click and Drag—Selects and moves an object. All
previously selected objects remain selected and are also
moved.

12



Outside of a Graphics Object:

Click and Drag—Selects all objects within the selection
rectangle. All previously selected objects are
de-selected.

Shift-click and Drag—Selects or de-selects all objects
within the selection rectangle. All other previously
selected objects remain selected.

When Editing Text:

Click—Moves the insertion point to the place clicked.
Any previously selected text is de-selected.

Shift-click—Extends the current text selection to the
place clicked.

Click and Drag—(Click and hold down the mouse
button.) Selects a range of text.

Double-click and Drag—Selects a range of words.
Selected objects remain selected.

In Dialog Boxes:

Click—Selects a single item. All previously selected
items are de-selected. Also moves the cursor to a text-
entry field. A highlighted box is the pre-selected input
field where typing will be displayed.

13
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When the main menu for Storybook Weaver: World of Make-Believe | The Main Menu
appears, you may start a new story, finish or edit a story that you
began earlier, print a story, or choose a story to read. You may also
exit Storybook Weaver: World of Make-Believe by selecting “
would like to quit now.” You may select any option from the main
menu by clicking on the menu icon.

Edi

Start a new story.

Choose a story to finish.

Choose a story to print.

Choose a story to read.

I would like to quit now.

Start a new story:

If you are ready to begin writing a new story, select “Start a new
story.” This option will take you to the title page where you can enter
the title of your story, the author, and other information.

Choose a story to finish:

If you have a story you have already saved on a data disk and you
would like to finish writing that story, or if you have a story you have
written that you would like to edit, select “Choose a story to finish.”
You will need to have the data disk where your previous story is
saved. When selecting this menu option, your story document will
open to the page you were on when the document was last saved.

Choose a story to print:
Once you have written a story, you can print a copy of your story. If

so, select “Choose a story to print.” The program will ask you to
locate the story you wish to print.

15
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The Title Page

Choose a story to read:

This unique feature of Storybook Weaver: World of Make-Believe
allows you to access any saved story to read, much the same way that
you would read a printed storybook. In this mode, Storybook
Weaver: World of Make-Believe does not allow you to edit a story.

I would like to quit now:

Selecting this option allows you to exit Storybook Weaver: World of
Make-Believe.

If you have not yet authored a story using Storybook Weaver: World
of Make-Believe, select “Start a new story.” This will take you to
the title page where you can enter some information about your story.

On the title page, you can enter a title for your story, list the name or
names of the authors, and add other information such as the name of
your school, your teacher or class, the date, or a summary line for
your story. You can also select from a variety of borders to enhance
your title screen. The information you enter on the title page can be
edited at any time during the writing process by returning to the title
page. This is done by clicking on the left-page turning button at the
bottom of the screen. Once you reach the title page, the left-page
turning button will beep, indicating that you are at the beginning of
your story.

¢ File Edit Goodies

4 [ Title Page | =)
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To enter a title for your story: Entering a Title

Step1:  Click on the Title button. A text box with a blinking
cursor will appear on the title page.

Step2:  Use the keyboard to enter the name or title of your story.
The title will appear in large, bold font centered in the
text box.

Step 3:  Position your title on your title page by clicking on the
text box. When the resizing handles appear, move your
title to the location you desire.

¢ File Edit Goodies

Jack and the
Beanstalk

4ammmmm [Title Page | =)

To change the title of your story, click on the Title button. The title
text box will reappear around your current title. The blinking text
insert cursor will be positioned at the beginning of your current title.
You may now edit your title using normal text-editing procedures.
For further information on editing text, see page 40.

17
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Entering an Author | To enter the author or authors of your story:

Step1:  Click on the Author button. A text box with a blinking
cursor will appear on the title page.

Step2:  Use the keyboard to enter the author’s (or authors’)
names. This will appear in medium-size, bold font
centered in the Author text box.

Step 3:  Position the author’s name(s) on your title page by
clicking on the text box. When the resizing handles
appear, move your title to the location you desire.

&% File Edit Goodies

Jack and the
Beanstalk
Retold by

Ryan Andrew

¢uummms  [Title Page | =)

To change the author or authors of your story, click on the Author
button. The author text box will reappear around your current
author. The blinking text insert cursor will be positioned at the
beginning of the text box. You may now edit this information using
normal text editing procedures. For further information on editing
text, see page 40.

18



Info allows you to enter additional information about your story.

This may include the name of your school, your teacher or class, and

the date your story was written. You may also wish to use this box to
enter a summary of your story. Just like entering the title and author,

to enter information about your story:

Step1:  Click on the Info button. A text box with a blinking
cursor will appear on the title page.

Step 2:  Use the keyboard to enter the information you want to
include about your story. This information will appear in
a medium font centered in the Info text box.

Step 3:  Position your information on your title page by clicking
on the text box. When the resizing handles appear, move
your Info text box to the location you desire.

¢¥ File Edit Goodies

Jack and the
Beanstalk

Retold by
Ryan Andrew

An O1d English Fairy Tale
May 14, 1991

4mummmm  [Title Page | )

To change the information about your story, click on the Info button.
The Info text box will reappear around your current information. The
blinking text insert cursor will be positioned at the beginning of the
text box. You may now edit this information using normal text
editing procedures. For further information on editing text, see

page 40.

19
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Selecting a Border

You may select a border to enhance your title page. Storybook
Weaver: World of Make-Believe contains a selection of twelve pre-
designed borders. You also have the option to have no border on
your title page.

To select a border for your title page:

Step1:  Click on the Border button. The first of twelve pre-
designed borders will appear around the title page.

Step2:  Click on the Border button again. The second border will
appear surrounding the title page. Continue clicking the
Border button to scroll through the available borders until
you find the one you like. You may choose not to have a
border if you desire.

Step3:  You may need to reposition your text to fit within your
border. In Storybook Weaver: World of Make-Believe,
the text may also overlay the border.

& File Edit Goodies
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Your Storybook Weaver: World of Make-Believe Program disk
contains a border file that holds all of the available borders for use
with Storybook Weaver: World of Make-Believe. The colors of the
borders cannot be changed.
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On the title page, there are two text modes: an editing mode that
allows you to make text changes and a non-editing mode that allows
you to move text on the title page. To move into the editing mode,
click on the Title, Author, or Info buttons. The text box will appear
as a dotted outline box. In the non-editing mode, simply click on the
text region on the title page itself. The text box will be defined with
four black rectangles called resizing handles.

Colored text may be entered for the title, author, or information.
Each section of the title page may have the same or different colored
text. The first four rows of colors on the color palette are available
for coloring text. To color text, follow the steps listed below.

* Click on the Title, Author, or Info button. Then select the
color from the color palette in which you want your text to

appear.

» Select the text you wish to color by clicking on the
corresponding text box to select the text. Select the color
you desire from the color palette. The selected text will
appear in that color.

The text colors on the title page may be changed at any time by
returning to the title page and selecting another color.

In addition to coloring text, you may move text on the title page using
the non-editing mode. The text boxes may be resized using the
resizing handles, the small black rectangles that appear on the corners
of a selected text box. This allows you to customize the title page by
placing the title, author, and information anywhere you desire on the
title page.

21
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To resize a text box on the title page:

Step 1:  Select the text box you wish to resize. Clicking on the
text will reveal the resizing handles.

Step2: Click on one of the handles and drag the mouse until
your text box resizes to the shape you desire. Your text
will automatically fill the new dimensions of your
text box.

Step 3:  Drag the text box to the location you desire on the title
page.

Once you have entered your information on the title page, click on the
right-page turning button to proceed to the next page.

Choosing a If you are writing a new story, you will be asked to choose what your
Page Type new page will look like. Storybook Weaver: World of Make-Believe
provides two page types: picture and text or text only.

[ File Edit Goodies

What will your new page look like?
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The picture and text page provides for two or four lines of story text,
depending on the font size you select.

File Edit Goodies

bigger |smaller

»we|
flip | spell

LA
Color -

The text only page allows either eight, nine, or seventeen lines of
story text. Font sizes can be set under the Goodies menu or under
Preferences on the File menu. For more information on font size, see

pages 65-68.

Edit Goodies

bigger Lmller

wre| X
flip | spell

o

4msmmms | Page 1 | ——)
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The Main Work
Screen

Page type can also be set under Preferences in the File menu. The
default is set to “choice,” allowing you to select your page type. If
desired, you may set the page type to automatically default to picture
and text or text only. For additional information on Preferences, see
page 59. For our “Step-by-Step Look at Storybook Weaver: World of
Make-Believe” select a picture and text page.

If you select a picture and text page, the main work screen will look
like the screen pictured below. This is the main interaction screen
where you will create your storybook page. The main work screen
consists of five regions: the picture window, the story window, the
tool palette, the color palette, and the page-turning buttons.

Story
Tool Paletic Window  Picture Window
Edit Goodieg
bigger |smaller|
wee| ¥
flip | spell
o
—L | Page 1 | w—
Color Palette Page-Turning Buttons

The picture window is the largest portion of the main work screen.
This area is reserved for the placement of the scenery and the objects
you have selected to use in your story.

The story window is located directly under the picture window and is
reserved for your story text. The simple word processor used in
Storybook Weaver: World of Make-Believe allows for upper- and
lower-case letters and word wrap. Entering, editing, and deleting text
are explained, beginning on page 39.
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The tool palette is located along the left side of the main work screen.
This palette consists of eight buttons that allow you to select and
manipulate scenery and objects placed in your picture window. The
buttons found on the tool palette include scenery, objects, bigger,
smaller, flip, spell, stop, and trash. Each of these buttons is explained
in more detail on pages 26-39.

The color palette occupies the lower left side of the main work

screen. This palette is mmpnsed of 24 color choices that can be used
to color objects placed in your picture window. The first four rows of
colors on the color palette can be used to color text in the story
window. For more information on the color palette, see pages 41-42.

The page-turning buttons are located at the bottom of the main work
screen, just beneath the story window. The page-turning buttons
move you through your story one screen at a time, much like turning
the pages of a book. You can move forward or backward using the
right- or left-page-turning buttons. Your current page number is
displayed in the center rectangle between the arrows. Page-turning
buttons are further explained on pages 42-43.

25
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To gain an understanding of the picture window, you must have some
objects to manipulate. Objects you will use in the picture window
can all be obtained using the buttons on the tool palette. Using the
scenery button, you can create a setting composed of colors, scenes,
or part color and part scene.

Selecting Scenery

In order to place scenery in your picture window, you must:

Step 1:  Click on the scenery button on the tool palette.
Storybook Weaver: World of Make-Believe takes you to
the scenery selection screen that allows you to make your
scenery choices.

Step2:  Use the arrow cursor to select either “color” or
“scene” as your scenery option. The two rows of
buttons along the bottom of this screen provide
foreground and background choices. The top row of
buttons indicates the options available for the
background of your picture and the bottom row
indicates the options available for your foreground.

Step 3:  Select a background from the top row of choices and
a foreground from the bottom row of choices.

Step4:  Click on the “OK” button to return to the main work
screen.

The color choices available for your setting include:

¢ File Edit Goodies

@ Color
O Scene

@ Doy
DS Right

[ ok ]
White

White mmmmm
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The scene choices available for your setting include:
@ File Edit Goodies

IO Color
@ Scenel

@ Day
O Night

Foreground and backgronnd options can be intermixed to provide 36
possible color combinations and 36 possible scene combinations and
72 possible color and scene combinations. In addition, the night
scenes provide an additional 72 scenery options.
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Day and Night
Buttons

When you select “scenes” as your background and foreground
choices, the “Day” and “Night” buttons will be activated. To switch
between daytime and nighttime settings, simply click on the
appropriate buttons. To return the scene to its previous view, select
the other button. You can return to the main work screen by clicking
on the OK button.

The daytime or nighttime setting may be changed at any time by
returning to the scenery-selection screen and selecting your new
option.

& File Edit Goodies

The “Day” and “Night” buttons are active for scenes only. These
buttons are dimmed if you have chosen the “color” option for your

scenery.
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Your scenery may be changed at anytime during your writing. New |Changing the
scenery may be selected as you add pages to your story or you may Scenery

wish to edit or change your story to use a different setting. To
change the scenery you have placed in your story:

Step 1:  Click on the scenery button on the tool palette.

Step2:  Use the arrow cursor to select either “color” or “scene”
as your scenery option.

Step 3:  Select your background from the top row of choices and
your foreground from the bottom row of choices. Your
new choices will appear in your picture window.

Step4: Click on the “OK” button to return to the main work
screen.

The “objects” button on the tool palette allows you to choose from a | Choosing Objects
variety of objects to place in your picture window. Eight categories
of objects are available in Storybook Weaver: World of Make-
Believe: people (positions), people (storybook characters), animals
(realistic), animals (make-believe), nature, vehicles, shelter, and
things.

The people (positions) category contains a variety of people in
various positions and traditional dress. The people (storybook
characters) category contains a variety of characters that are found in
a wide range of folklore. The animals (realistic) category contains a
wide variety of realistic animals. The animals (make-believe)
category contains animals that are either make-believe or have been
personified in some way. Nature includes a variety of objects that
relate to weather, growing things, and nature objects in the
environment. The vehicles category contains a wide assortment of
vehicles found in many aspects of folk literature. Shelter includes
various buildings or homes that would be found in various settings.
Things includes a variety of objects that might be used by people in
various settings.
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Object

Categories Picture Window

Edit Goodies

noture juehicles

@ (wel

shelter] things

baby sitting boy crawling
baby baby sleeping |boy crouching

baby crawling |boy climbing boy kneeling
More Objects E

Selection Preview Box
Boxes

The objects-selection screen is composed of four major regions. The
categories appear on the left side of the screen in the same location
that you would find the tool palette on the main work screen. These
categories serve as a means to classify the more than 500 objects
available for placement in the pictures you create with Storybook
Weaver: World of Make-Believe.

The selection boxes contain the names of the actual objects that you
can place in your picture. The selection boxes display nine objects at
a time. More objects are available in each category. You can scroll
through the objects by clicking on the right or left arrows beneath the
object-selection boxes. This will allow you to move forward or
backward in the category to locate an object you wish to place in your
picture.

The preview box appears in the lower right corner of the screen. This
box allows you to view an object before placing it in your picture
window. It also serves to reinforce vocabulary as the picture appears
when the word is selected.
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The picture window, which is the same as the window on the main
work screen, occupies the largest portion of the screen and permits
you to place your selected objects immediately into your picture.

To select the objects you wish to add to your picture, you must: Selecting and
Placing Objects

Step 1:  Select objects from the tool palette on the main work
screen. When the objects-selection screen appears, the
upper left category, people (position), will be selected
and its choices will fill the selection boxes. In the upper
left selection box, “Arabian prince” will also be selected
and the corresponding object will appear in the preview
box at the lower right corner of the screen.

Step 2:  Locate the category from which you wish to select an
object.

Step 3:  Locate the object you wish to place in your picture.

Step4: To place an object from the preview box onto your
picture window, click and drag the object from the
preview box to the location you wish the object to
appear.

Step 5:  Release the mouse button to place the object.

File i Goodies

dg duck

Chinese dragon |dragon duckling
dragonfly fawn

¢ | More Objects E
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If you drag an object from the preview box onto the picture window
but don’t release the mouse button to place the object, you can drag
the object back into the preview box to dispose of it. Objects placed
on the picture window by dragging and releasing the mouse button
may not be dragged back into the preview box.

You may place a maximum of 50 objects in the picture window on a

given story page.

bow and arro

You have reached the limit
of 50 objects. This object
cannot be created.

|brick wall

butter churn

bowl

broom

bread

¢ssmms | More Objects | )

cage

cake
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You may move objects within your picture window at any time
during the creation of your picture. To move an object in the picture
window:

Step 1:  Select the object you wish to move.

Step2: When the “handles” appear, click anywhere on the
object and drag it to its new location.

Step 3:  Release the mouse button to place the object in your
picture.

You can move several objects at once by holding down the Shift Key
and clicking on the objects you wish to move. When the group of
objects has been selected, drag the objects to the new location.

MOnce upon a time there was a poor widow who had an
nly son named Jack, and a cow named Milky=-white.
[ ]And al they had to Tive on was the milk the cow gave
Nevery morning which they carried to market and sold.

4ssmsmms | Page 1 | ooesss—)

In addition, holding down the 3 Key while pressing one of the arrow
keys will move any selected object or objects one pixel in the

direction specified.

Moving Objects
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Deleting Objects Objects that you have placed in your picture window may be deleted
in several ways. If you are on the main work screen, you may
remove objects from your picture by:

Step 1:  Selecting the object or objects you wish to delete from
your picture.

Step2:  When the handles appear, click the trash button located
on the tool palette. The selected object or objects will be
removed.

You may also remove objects either from the main work screen or the
objects-selection screen by selecting the object or group of objects
you wish to delete and pressing the Delete Key.

An entire page of objects may be removed by choosing “Select All”
from the Edit menu and using the trash can icon or the Delete Key.
You can also delete an entire page of objects by selecting Clear under
the Edit menu.

Objects that have been deleted can be retrieved by selecting Undo
Clear under the Edit menu. This operation must occur immediately
after the objects have been deleted.

Making Objects Once you have placed some objects in your picture window and have

Bigger returned to the main work screen, you may manipulate these objects
using the bigger, smaller, and flip buttons that appear on the tool
palette.

The bigger button allows you to increase the size of an object in
incremental steps. To enlarge an object:

Step 1:  Select the object you wish to enlarge by clicking on the

object to select.

Step2:  When the handles appear, click on the bigger button to
resize the object.

Step 3:  If the object is at its maximum size, the object will
remain unchanged.
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You may enlarge a group of objects at the same time by selecting the
objects you wish to enlarge and clicking the bigger button.

¢¢ File Edit Goodies
Xl RS
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But one morning the cow gave no milk, and they didn‘'t
know what to do. “Don’t worry, Mother. Today is
market day. | will take her to town and sell her.” So
D Jack set off for town.

N [ Page 2| we———)
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The smaller button allows you to reduce the size of an object in Making Objects
incremental steps. To reduce the size of an object: Smaller
Step 1:  Select the object you wish to reduce by clicking on the
object to select.
Step2:  When the handles appear, click on the smaller button
to resize the object.
Step 3:  If the object is at its minimum size, the object will
remain unchanged.

You may reduce the size of a group of objects at the same time by
selecting the objects you wish to resize and clicking the smaller

button.
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‘Good morning, Jack," he said. “Good morning to go;.l,"
| |said Jack, wondering how the man knew his name. “| am
1going to market to sell our cow."”

ommmms | Page 3 | =)

Any object that has been resized using the bigger or smaller buttons
may be returned to its original size in one of two ways:

e Select the object that has been resized by clicking on the
object to highlight. Select Ideal Size from the Goodies menu.
The object will revert to its predrawn or best size.

e Select the object. When the handles appear, click on
the trash can icon to delete the object from your picture
window. Select a new object by clicking on the objects
button from the tool palette and retrieve a new object from
the objects-selection screen.

To change the direction of an object or group of objects, you can use
the flip button that appears in the tool palette on the main work
screen. To change the direction of an object, you must:

Step 1:  Select the object or objects you wish to flip by clicking
on the object to select.

Step2: When the handles appear, click on the flip button to
change the orientation of the object.

Step 3:  The object will appear facing the opposite direction.
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ou seem the sort 0 ad who vn"ll ge a go d price,
said the man. "INl happily swap these magic beans for
your cow. Plant them at night and by morning they'll
grow right up to the sky.” Jack handed over the cow.

mmssss | Page 4 | =)

Children’s oral-language skills are often more developed than their | The Spell Button
written-language skills. In Storybook Weaver: World of Make-
Believe, the primary focus is on the writing process. Therefore, the
Spell button offers a unique feature in that it allows you to place the
word of a selected object in your story text even if you don’t know
how to spell the word. To operate the Spell feature:

Step 1:  Select the desired insertion point in your story window
by placing the insertion point in the location you want
the object word to appear.

Step 2:  Move into the picture window and use the arrow cursor
to select the object you want to include in your story.

Step 3:  Click on the “Spell” button on the tool palette.

Step4: The selected object’s name will appear in the story
window at the insertion point you designated. The
insertion point will appear after the spelled word so
that you may continue to work on your story.

The name or label for the object you select will be the same name
that appears in the selection boxes on the objects-selection screen.
Only those objects that you currently have placed in your picture

window may be used with the Spell button for insertion into your

story.
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“You seem the sort of lad who will get a good price,”
said the man. “I'll happily swap these magic beans for
your cow. Plant them at night and by morning they‘ll
grow right up to the sky.” Jack handed over the cow

4ommms | Page 4 | =————)
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Stop and Trash Two additional buttons that appear on the tool palette are Stop and
Buttons Trash. Selecting the Stop button will allow you to quit your current
story. You will be prompted to SAVE your story before quitting.

The trash button allows you to delete any object or objects that you
no longer want in your picture window. To delete an object using
the trash can icon, you must:

Step 1:  Select the object or objects you wish to delete.

Step2: When the handles appear, click on the trash can button
on the tool palette.

Step3:  The object or objects will be deleted.
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If you have chosen a picture and text page, the story window The Story Window
occupies the lower one-third of the main work screen and is reserved
for the text portion of your story. For a text-only page, the story
window occupies the entire picture window and story window area.
Storybook Weaver: World of Make-Believe uses a simple word
processor with word wrap and upper- and lower-case letters.

To enter your text in the story window, use the keyboard in a typical | Entering Your Story
word-processor manner:

Step 1:  Select the size of the text you want in the story window.
You may choose either small, large, or fancy font. Font
size is set under the Goodies menu or under Preferences
on the File menu.

Step2: Move your cursor to the story window on the main
work screen. The I-beam cursor will appear.

Step 3:  Select the insertion point by clicking the mouse at the
location in the story window you wish to begin writing.

Step4:  Use the keyboard to enter your story.

When the story window is full, you will receive the following
message:
¢ File Edit Goodies

The text object has become
longer than the page. The
extra text will be lost.

“You seem the sort of lad who will get a good price,"
aid the man. “I'll happily swap these magic beans for
our cow. Plant them at night and by morning they 'l
row right up to the sky.” Jack handed over

4ammmmsm | Page U4 | ——
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Editing Your Story

The insertion cursor may be moved to any position in the text
window using either the arrow keys or by using the mouse’s I-beam
cursor to point and click at the desired insertion point.

Text may also be “pasted” into the text window using the cut, copy,
and paste commands available under the Edit menu. For more
information on the editing features, see page 63 in the “Exploring the
Features of Storybook Weaver: World of Make-Believe” section of
this manual.

You may edit or change your story text anytime during the writing
process simply by moving to the story window.

To insert a word or words in your story text:

Step 1:  Move the insertion point cursor to the location in your

story where you want to add words.

Step2:  Use the keyboard to enter the word or words you wish
to add to your story.

To change or edit words in your story:

Step 1:  Move the I-beam cursor to the beginning of the text
you wish to change.

Step2:  Hold down the mouse button and drag the cursor to
highlight the text you wish to edit.

Step 3:  Release the mouse button to select the text.
Step4:  Use the keyboard to enter the text you wish to add to

your story.

You may also select text to edit by holding down the Shift Key and
using the arrow keys to move the cursor and highlight text you wish
to edit.




Text may be deleted from your story using any of the following
methods:

» Highlight the text you wish to delete and press the Delete
Key.

» Highlight the text and select Clear from the Edit menu.

» Highlight the text and select Cut (3-X) from the
Edit menu.

*  When in the story window, choose Select All from the Edit
menu and press the trash icon, the Delete Key, or the Clear
Key.

The Spell button on the tool palette allows you to place text for
objects appearing in your picture window in your story. For
information on the Spell button, refer to page 37.

The color palette occupies the lower left corner of the main work
screen. The color palette allows you to color the objects you have
placed in your picture window. You may also color the text that
appears in your story window. Twenty-four colors are available on
the color palette.

To color an object using the colors on the color palette:

Step 1:  Select the object or group of objects you wish to color.

Step2: When the handles appear, click on the color you desire
from the choices available on the color palette.

Step 3:  The selected object or objects will become that color.

Objects appear fully colored in the preview box. One color on each
object, generally the major portion of the object, is changeable. To
determine which portion of the object will change color, simply click
on the object to select and then click on a color on the color palette.

RERONRRS

Deleting Text from
Your Story

Using “Spell”

The Color Palette
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If you have changed an objects color, a “Restore Color” option,
which appears under the Goodies menu will allow you to return the
object to its pre-drawn color. To use, simply select the object desired
and select “Restore Color.” The object will return to the colors in
which it originally appeared in the preview box.

The text in the story window, as well as the text that appears on the
title page of your story, can also be colored. The first four rows of
colors on the color palette are available for coloring text.

To color text using the colors on the color palette:

Step 1:  Move your cursor to the story window on the main

work screen.

Step2:  Select the color you desire from the choices available
on the color palette.

Step3:  Use the keyboard to enter your story text. All text will
appear in the selected color.

To change the color of your story text:

Step1:  Click in the story window to activate your cursor.
Step2: Once your insert cursor is active, click on the color

you desire from the choices available on the color palette.
Step 3:  The text will become that color.

You can also select text by clicking and dragging to highlight. Then
click on the color you desire from the choices available on the color
palette.

The color of objects and text may be changed at any time by
reselecting the object or text and repeating the procedure outlined

above.
Page-Turning You can move from one page to another in your story simply by
Buttons clicking on the left- or right-page-turning buttons that appear at the

bottom of each page. The page-turning buttons operate in much the
same manner as turning the pages of a book. You will use the right-
page-turning button to proceed to the next page. If the next page of
your story is also a “new” page, you will be prompted as to what you
would like the new page to look like—picture and text or text only.
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Clicking on the left-page-turning button will take you to the previous
page completed in your story. You may continue to click the left-
page-turning button until you return to the title page of your story.
The current page of your story is indicated in the rectangle between
the left- and right-page-turning buttons.

¢ File Edit Goodies
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There was no time to lose, for the Giant was already
half way down the beanstalk. With one slashing blow
Jack cut the beanstalk in two. The Giant came crashing
to the ground Jack and his mother lived happily ever.

4ummmms | Page 50 | se—s=)
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Storybook Weaver: World of Make-Believe has a page limit of fifty
pages per story. When you have reached the page limits of
Storybook Weaver: World of Make-Believe, the right-page-turning
button will beep.

Additional page options are available under the Goodies menu and
are explained on pages 70-73.
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[ File Edit Goodies ]

This is the Storybook Weaver: World of Make-Believe menu bar.
Each item contains a separate pull-down menu. When you hold
down the mouse button while pointing the arrow cursor at one of the
menu items, the menu will pull down and display the individual menu
items.

The menus contain other functions in Storybook Weaver: World of
Make-Believe: text options, picture and object features, and page
options.

Each menu is discussed separately in this section. We begin on the
left with the 8 menu and proceed to the right, finishing with the
Goodies menu. With each menu, we begin at the top and move to the
bottom, discussing each menu item in turn. The ® menu provides
access to Storybook Weaver: World of Make-Believe information,
help, and any desk accessories installed on your system. The
Storybook Weaver: World of Make-Believe System disk comes with
three desk accessories: Control Panel, MECC Key Caps, and Disk
Accessory.

About Storybook Weaver...
Help... a?
Control Panel
MECC Key Caps
Disk Accessory

About Storybook Weaver ...

StOl‘E]BOOE, chwer

World of Make—-Believe
Version 1.0

by Charolyn Kapplinger,
Patricia Korn, and Jean Sharp

The Menu Bar

The Apple Menu
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When you select About Storybook Weaver..., the screen displays
the product name, the MECC development team, and other
information about Storybook Weaver: World of Make-Believe.

Help... (3-7)

Help provides you a list of topics that you can select to get more
information. The page numbers refer you to the manual for further
explanation.

Help Topics

Apple Menu Cpages 45-53) [}
Color Palette Cpages 41-42)
Cursors Cpages 11-12)
Edit Menu (pages 63-635)
File Menu Cpages 53-63) =
Goodies Menu Cpages 65-73)F
Main M:nu Options (pcses 15-16)E

12-13) |3

Control Panel

The Control Panel (standard on the Apple IIGS) allows you to select
from a list of devices that are connected to your computer directly or
over an AppleTalk network. When you are using Storybook Weaver:
World of Make-Believe on an AppleTalk network or when you have
more than one printer connected to your computer, you will use the
Control Panel to select a printer.
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=0 Control Panel
. —0- Select a Port:

AT IWriter i3

[ ] P 1lel.Card
g_! ara 5

DC Printer
Select a Printer Type:

= Imagellriter 1)
O

The Control Panel displays icons of the available devices on the left.
If there are more than five devices, the list becomes scrollable.
Devices could include a variety of printers, modems, drives, and
servers. The current device is highlighted.

A printer device might be an AppleTalk ImageWriter (AT IWriter), a
Direct Connect (DC) Printer, or a LaserWriter. If there is more than
one similar device, selecting an AppleTalk ImageWriter will prompt
you to select one from a list of ImageWriters in the upper right. You
can also specify in which zone to look for an AppleTalk
ImageWriter—should your network have more than one zone. If you
are not on an AppleTalk network, the AppleTalk Zones box is blank.
AppleTalk networks must have at least one zone, each with its own
set of available printers, modems, and other devices.

The Control Panel provided with the Storybook Weaver: World of
Make-Believe System disk is specifically for device selection and
should not be confused with the Control Panel for the Apple IIGS.
The Apple IIGS Control Panel is used to specify a variety of settings
for the computer itself: display, sound, clock, speed, slots, printer
and modem ports, and RAM disk.
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MECC Key Caps

MECC Key Caps allows you to find a complete set of diacritical
marks and foreign language and special characters available with
each font so that you can locate the characters needed to enter text
in a foreign language. When you select MECC Key Caps, you will
see a keyboard diagram that shows the keys in the current font.

(| NECC_KQ!J Caps 1.3

|1|2|3|Hl5|6|7|8|9|0|—|=| = |/ |%*
qglwlejritiyjulijo|pil |] 7|8|9|+
alsid|flglh kill:|® yis|6|-
zxcvblnm] l.]/] 1|23
11 B¢ NEERRER

By holding down the Shift Key, the Option Key, the Apple Key, the
Control Key, or any combination of those keys, the set of characters
associated with those key combinations is displayed on the keyboard
diagram. The selected font is the system, or “Shaston,” font. The
Choose Font button in the top right corer allows you to select a
different font, style, and size.

MECC Key Caps font selection:

Font:
Geneva
London

Style:

Plain ]| Size:
[CJBold ]
CJ1icalic

Junderline

CJ outline .
[J shadow e ok ]

Any text copied from Key Caps to Storybook Weaver: World of
Make-Believe will appear in the standard font chosen for the

program.
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Disk Accessory

Disk Accessory allows you to perform certain disk operations, such as
formatting a disk, deleting, or renaming a file without exiting
Storybook Weaver: World of Make-Believe. When you select Disk
Accessory, you will see the following screen:

O Disk Accessory
Available Disks: (Disk Scan )

:System.disk [{}|

:StoryBook (Initialize)
I [ Eject )

T ([ Delete ]

b TR, |G

Free Space: 6K [ Rename )

The scroll box on the left side of the screen contains the disk volumes
that are currently available. When you click on a disk volume in the
scroll box, you will get information about that volume. Disk
Accessory will display the disk type, size of the volume, and disk free
space. If there is no disk in the drive, the device name will be
displayed with the <greater than> signs around it.

Disk Scan will update the devices currently displayed in the scroll
box. If you have inserted or removed disks or devices, you may wish
to scan disks.

In order to save your story documents, you can initialize either a 3.5"
or a 5.25" disk with Disk Accessory. To initialize a disk using Disk
Accessory, select the “Initialize” button.

You will be presented with this alert:
@ This operation will
PERMANENTLY destroy all

data on this disk. Are you
sure you want to do this?

[ Cancel ) [ Continue )
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You may proceed with the initialization process or select “Cancel,”
which returns you to the main window. If the disk you inserted is
formatted, the following alert is presented:

PERMRNENTL\’ destrou all
data on the dis
"APPLEDISKS3. 59)" Are you
sure you want to do this?

@ This operation will

( Cancel ) [ Continue )

If you indicate that you want to format the disk, you can enter a name
for the disk. The following dialog is displayed:

Enter a name for this disk:
[Untitled] ]

( Cancel ) (Initialize]

Selecting “Initialize” will format the disk. Once this process is
complete, Disk Accessory returns you to the main window.

Selecting “Eject” will remove your disk from the selected drive.

@ Unable to perform because
of an 170 error.
[ ok ]
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Delete may be used to remove files and folders from the selected disk
volume. When you select “Delete,” the Disk Accessory presents the
following dialog box:

B:SBW3:
Select the file to Delete:

(_Disk )
OM.Believe.Prefs =1 —

G Make.Believe |m|
OPRODUCT.INFO
DOWeaver.data (Close )

{ Delete )

3| ([ Cancel )

Folders may be opened or closed from this screen. You may delete
files and folders or return to Disk Accessory’s main window by
selecting “Cancel.” To delete a file, highlight the file you wish to
delete. Click on the delete button that appears on the right side of the
screen. Disk Accessory will display the following alert:

& Are You sure you want to
PERMANENTLY delete the
file *""Borders*?

(_Cance1 ] [ ok ]

You may cancel either procedure by selecting “Cancel.” You will be
returned to the “Delete” screen.

Get Info allows you to view the known information about a file. You
may also set information for a particular file. When you select this
option, a standard file dialog is displayed. Once you select a file, the
following dialog is presented:
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Get Info

Name: MAKE.BELIEVE
Size: 110K on disk

Created: 02/728/791...09:56
Modified: 05/01/791...10:40

Where: /StoryBook/MAKE.BELIEVE

Tupe: $B3 [CJLocked
Aux Type: $0000

( Cancel )

You may lock or unlock a file by clicking in the box labeled
“Locked.” An X will appear when a file is locked.

“Rename” gives you the option of entering a new name for a file.
When you select “Rename,” the following dialog box is displayed:

&:SBW3:
Select the file to Rename:
s BORDERS 71 [_Disk )
OM.Believe.Prefs | ey
AQMake.Believe Il Open |

DPRODUCT.INFO

DWeaver.data [ Close )

[ Rename ]

&l ([ Cancel ]

You must select the file you wish to rename by clicking on that file to
highlight. Once the file has been selected, the following dialog is
displayed:

Rename: Borders
To: ]

( Cancel )
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Enter the new file name and select “Rename.” You may cancel this
procedure by selecting “Cancel.”

Clicking on the area of the main menu screen above the scroll box
will give you information about Disk Accessory. The screen includes
information about Disk Accessory, the MECC development team, and
other information.

Disk Rccessory
Version 1.1
Copyright MECC, 1990

Written by Vincent J. Erickson

_MECC
3490 Lexington Rvenue

St. Paul,K MN 55126-8097
C612) 481-3500

To quit the Disk Accessory, click in the close box, the small rectangle
that appears at the top left comer of the menu bar.

The File menu provides access to the basic functions of the
program—opening, saving, and closing documents—as well as the
document preferences, page setup, and printing functions. The File
menu also includes the option to quit Storybook Weaver: World of
Make-Believe.
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This is the File menu: m

Reyvs AN
Guen.. A8
Close al
Save as
Save As...

Bewvert. Tao Soved
Preferences...
Page Setup...
Print.. aP
Quit aqQ

New (G-N)

This menu item creates a new, untitled story for Storybook Weaver:
World of Make-Believe. A new story document will have the
specifications set under Preferences. See Preferences... in this section
for information on how to change these settings. New documents are
named “Untitled.”

In Storybook Weaver: World of Make-Believe, a new document can
be created by selecting “Start a new story” from the main menu.

Open...(G-0)

This menu item opens a previously saved Storybook Weaver: World
of Make-Believe document to edit or finish. Open brings up the
standard Open dialog box.

Select file to open:
®:Data:
(9 Ana pide ¢|( Volumes )
O Bluebonnet
D Jack.Beanstalk

D Monkey.Crocodil

D Paper.Crane G Open D

D Red.Riding.Hood ( Close )
Ol Cancel )




The dialog box contains a scrollable list of Storybook Weaver:
World of Make-Believe documents. Use the scroll bar and scroll
arrows to move up and down the list of files. The scrollable list of
folders and file names is in alphabetical order. You can select the file
by double-clicking on it or by clicking the Open button when the file
you want is highlighted. Once the story file has been opened, you
will find yourself on the last completed story page.

You can switch the drive from which the files should be opened by
clicking the Disk button in the dialog box or by pressing the Tab Key.
You can also save documents on 5.25" drives by selecting the 5.25"
disk drive control device from the Control Panel.

Close (3-W)

This menu item closes the story document but does not exit
Storybook Weaver: World of Make-Believe. If you have not saved
all of your changes, you will be asked whether you would like to save
your work. The alert box looks like this:

& Save changes before closing?

{ Cancel ) [Don’t Save)

If you press the Cancel button, you will return to the document.
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This menu item saves the story document with its current name. Save
replaces—without any prompt—the older version of the story
document. If you have not saved the story document before, you will
be prompted to name the story document.

With a new story document, the pre-set name is “Untitled.” This
name appears in the Save As edit box that prompts you to name this
file. To erase the name “Untitled,” you can:

» press the Delete Key and erase characters one at a time;

o press the Clear Key (upper left corner of the 10-key keypad);
or

» double-click on Untitled to select for replacement.

Then enter the name you wish to use.

®:Data:

272 free of 800 k. (
T Rnansk.Splder [t}
Blunbonnet B
G Jdoack.Deons tali : -
gs:fank mé.(:roeotiii 4 gpern ]
L Paper.Crane -

| Ci Red Riding Hooy [](__Close )

Save as: ey,

Volumes )

{ New Folder )

Cancel

File Names. On a stand-alone machine using GS/OS, file names
may contain letters or numbers, such as “letter” or “letter12.”
Letters can be in upper- or lower-case, such as “MyStory.” They
may have extensions, such as “story.sept” or “story.sept14,”
separated by a period. File names may be up to 15 characters long,
such as “Congratulations.”
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File names cannot:
* have only numbers in the name, such as “14”;
* begin with numbers, such as *“14sept.story”;
 use special characters (@#&*/), such as “story#1/sept/14”;
» have any punctuation marks except the period (1?,;:),
such as “Hello!”’; or
* contain spaces, such as “My Story.”

If you try to save a file name that is not acceptable, you will see this
system message:

Error saving the file:
The pathname has changed or is now

in error..

Basically, what the system message is trying to tell you is that the file
name is not acceptable. If you get this message, first check your file
name to see if it has any of the special characters or a space in it.
Then, check to see if there is a folder or active disk with that name.
In any case, you will need to change the name of the file to save it.

It is a very good idea to regularly save your work to prevent losing
anything in the event of a power interruption or surge or other
system-related problem. Depending on the amount of memory in
your machine and the size of your story document, you may get an
alert message to save because of low memory.
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Memory is running low. Be
sure to save your document
frequently.

ok ]

If this ever happens, save your story document immediately. If you
ignore this message, continue working, and attempt to save later, you
may not have enough memory to completc the operauon and will
lose all the work since you last saved it.

Save As...

This option allows you to save the document currently in use with a
different name (thus preserving the previously saved version of the —
document) and/or on a different disk.

Revert to Saved

This option replaces the document on the screen with the latest
version saved. This is the same as throwing out all changes since the
last save. If the document has never been saved or if the document
has not been modified since it has been saved, the item is dimmed.
Before reverting to the old document, you will be warned with this
alert:

Revert to the last saved
version of your document?
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Preferences

This menu item allows you to set permanent system preferences that
will be stored on the disk and will be used as the initial preferences
with each new story document.

You can specify the initial font size to appear in the story window.

If you have chosen a picture and text page, small font allows for four
lines of story text and large font or fancy font allows for two lines of
story text. On a text-only page, selecting small font will provide for
seventeen lines of story text and large font will provide nine lines of
story text while fancy font provides eight lines of story text. To
change from small font—the default selection—click on the large
font or fancy font button.

Preferences also allows you to set the page type for each new story
page. “Choice” is selected as the default, which means that each time
you use the page-turning buttons to take you to a new page, you will
be given the choice of creating a page that contains picture and text or
text-only. You may change the page type under Preferences so that
the new page type will automatically be selected as pictures and text
or text-only if desired.

The changes made under Preferences take effect on your new story
page.

You may determine the movement of objects in the picture window.
The default is set for objects to appear in the order in which they
were brought to the picture window. To move an object in front of
another object, you must use the Bring to Front option on the
Goodies menu. By selecting “Bring Objects to Front When Moved,”
objects that are selected and moved to a new location will appear in
front of other objects.

59



Storybook Weaver: World of Make Believe

You may also determine how new objects appear from the preview
box to the picture window. If you would like the objects to come to
the picture window in the same size as they are shown in the preview
box, select preview size. If you would like new objects to appear in
the picture window in their ideal size, you may select that option. In
selecting Ideal Size, some of the objects will spring to their optimum
size once you release the mouse button to place the object in the
picture window.

The final option you may set under Preferences is the printed format.
This refers to the number of story pages that will be printed on each
printer page. The current default is set to print one story page per
each printer page. If you choose, you may have Storybook Weaver:
World of Make-Believe print two story pages per each printer-page
or big-book format that provides a 2 x 2 printout of each story page.

Preferences

Font: New Objects Appear: .y

@ Small @ Preview Box Size

QO Large O 1deal Size

QO Fancy

Page Type: Printed Format.

@ Choice . i

O Picture & Text l

O Text Only

[ Bring Dbjects to

Front When Moved - -

Page Setup...
This menu item calls up the standard Apple IIGS Page Setup dialog
box for the printer selected in the Control Panel.
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You can select paper size, vertical sizing, and any printer effects. For
specific information on each of these options, consult your Apple IIGS
Owner’s Guide.

LaserlWriter v3.1

Paper: @ US Letter QO AUY Letter
O US Legal O BS Letter
entation: Vertical Sizing:

@ Normal
. QO Intermediate
O Condensed
Prxnt.er Effects:

Reduce or 0
] Smoothing? Enlarge: : 3
=] Font Substxtutuon'o‘

Imagellriter / Printer wvu.1
Paper Type: [ US Letter...... 8.5""x11""
Reduction: [ Full Size }
Height: [CINo Vertical Gaps
[ vertical Condense
Orientation:
— = . | [ oK )
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Print... (3-P)

This menu item prints the story document to the currently chosen
printer. Depending on the selection you have made in the Control
Panel, you will see the standard Apple IIGS Print dialog box for the
LaserWriter or the ImageWriter:

LaserWriter v3.1
Pages: @ Al11l

Serom: [ To: [
Copies:
Paper Source:

@ Paper Tray

O Manual Feed

ImageWriter /7 Printer vi.1l

Copies:
Pages: @ A1l O Range

From [

A —
Quality: [ Standard
Chroma: [ Color }

Sheet Feed: [ _fAutomatic
I oK 1]

You can print all the pages or select a range of pages from the story
document, specify the number of copies to print, and select “Manual
Feed” or “Paper Tray” as the paper source. Storybook Weaver:
World of Make-Believe allows for story documents of up to fifty
pages. The title page is designated as page 0.

Refer to your Apple IIGS Owner’s Guide for additional information
on the options available for printing.
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Quit (3-Q)

This option allows you to exit Storybook Weaver: World of Make-
Believe. If there were any changes in the currently open story
document that haven’t been saved, the following alert will appear:

& Save changes before quitting?

[ Cancel ] [Don’t Save])

The Edit menu manages the manipulation of story text and objects. The Edit Menu
You can cut, copy, and paste selections of story text and objects.

This is the Edit Menu.
oo A2
Cut ax
Copy aC
Paste av
Clear |
Select All 4&Aj

Undo (3-Z)

This menu item will undo your last action. The specific name of the
menu item will depend on which action is to be undone. When you
are typing text, it will read “Undo Typing.” If this were executed,
the menu item would then read “Redo Typing.” If you selected text
and cut it, it would read “Undo Cut.” It is dimmed when unavailable.

Undo will undo Cut, Copy, Paste, and Select All commands, any
changes to font size, and any deleted object or text. Undo will also
undo Clear, Move object, and Color object.
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Cut (3-X), Copy (3-C), and Paste (3-V)

These menu items remove, duplicate, and place selected text or
objects. They act like they do in other applications and are dimmed
and inactive if there is no text or object selected. Selected text can
be a range of characters, a word, or a range of words. You can
select text by using shifted arrow keys, by dragging the mouse, or by
using Select All

Cut removes text from its current position and holds it in memory so
that it can be pasted in some other location. Cut can be invoked by
pressing G-X. A second cut replaces any text or objects previously
cut.

Copy duplicates selected text so that it can be pasted at some other
location and holds the duplicated text in memory until another Copy
or Cut is performed. Copy can be invoked by pressing -C. A
second copy overwrites any text or objects that had been copied.

Paste takes whatever text has been cut or copied and places it at the
current insertion point. Move the I-beam to where you want to paste
the cut or copied text, click the mouse to create the insertion point,
and select Paste or press G-V. Text that has been copied can be
pasted multiple times.

When you use Cut and Copy, you hold this text in memory in a
place called the clipboard. Text will stay in the clipboard until you
copy or cut a second time.




Storybook Weavel“ World of Make-Belneve
g the Features of Storybook Hd of Make:

Clear

This menu item deletes the current selection. If something is cleared,
it cannot be pasted later. This menu item is dimmed if nothing is
selected. Clear works for text and objects in the picture window,
deleting the currently selected text or objects. Cleared text or objects
cannot be pasted later.

Select All (3-A)

This menu item selects all of the text in the story window or all of the
objects in the picture window on the current story page.

The Goodies menu manages the manipulation of text size in the story | The Goodies Menu
window, object size, and page features.

This is the Goodies Menu.

v Small Font
Large Font
Fancy Font
Bring to Front GF
Send to Back aB
Restore Color GR
Ideal Size al
Delete Page
Insert a Page
Copy a Page...
Swap Pages...
Go To Page... a6

Small Font

This menu item allows you to change the size of the text that appears
in the story window. If you have chosen a picture and text page,
selecting small font will give you four lines of story text. If you have
chosen a text-only page, selectmg small font will provxdc seventeen
lines of story text. Small font is selected as the default in Storybook
Weaver: World of Make-Believe.

65



Storybook Weaver Worldof Make Belleve

Edit Goodies _

In the morning when Jack woke up, a huge beanstalk was
growing right next to the house. It went up and up and
| Jup until it reached the sky. Jack climbed right on to the
& |beanstalk. Higher and higher he climbed.

4ummmss | Page 6 | ee—)

Large Font

This menu item allows you to change the size of the text that appears
in the story window. If you have chosen a picture and text page,
selecting large font will give you two lines of story text. If you have
chosen a text-only page, selectmg large font will provide nine lines
of story text. The larger text is sometimes desired for young readers
and writers.

&% File Edit G6Goodies
50 %

ceneryjobjects oS S

| e :

bigger smal

fip | spen AR LY

£
w I

In the morning when Jack woke 'up,
a huge beanstalk was growing right

4umsmms | Page 6 | on—
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Fancy Font

This menu item allows you to change the size of the text that appears
in the story window. If you have chosen a picture and text page,
selecting fancy font will give you two lines of story text. If you have
chosen a text-only page, selecting fancy font will provide eight lines
of story text. The fancy font may be desired for fairy-tale writing.

& File Edit Goodies
. F 20
sceneryjobjects Fox

*
bigger jsmuller 2

wrer| B 4
flip | spell LX)

Il trosh

Color -

A

.

Tun the morning when Jack
twoke up, a huge beaustalk

4mmumss | Page 6 [ ——)

Font size may be changed under the Goodies menu or under
Preferences in the File menu.

If you have entered text in small font and decide to change the text
size to large or fancy font, you may receive the following alert:
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¢& File Edit Goodies

b %Xo) A
sceneryjobjects . a K s
5T ve reveen
bigger :
v The text object has become
flip longer than the page. The
. extra text will be lost.

[ ok ]

n the morning when Jack woke up, a huge beanstalk was
growing right next to the house. It went up and up and
up until it reached the sky. Jack climbed right on to the
beanstalk. Higher and higher he climbed until he came to

¢ummms | Page 6 | =————)
This message warns you that some of your text will be lost. Lost text
cannot be recovered.
Bring to Front (G-F)

This menu item brings the selected object in the picture window to
the foreground, in front of other objects. In effect, this option
reshuffles the object order and places the selected object at the top of
the pile.

& File Edit Goodies
P R
sceneryjobjects AN

# Iﬂn:ﬁer

bigger

fip | spen PSR SX

A,
o B

<.

in the morning when Jack woke up, a huge beanstalk was
growing right next to the house. it went up and up and

up until it reached the sky. Jack climbed right on to the
beanstalk. Higher and higher he climbed until he came to

émmmms | Page 6 [ ——)
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Send to Back (G-B)

This menu item sends the selected object in the picture window to the
background, behind other objects. In effect, this option reshuffles the
object order and places the selected object at the bottom of the pile.

Edit Goodies

in the morning when Jack woke up, a huge beanstalk was
growing right next to the house. It went up and up and
up until it reached the sky. Jack climbed right on to the
beanstalk. Higher and higher he climbed until he came to

s | Page 6 | ——

Restore Color (3-R)

This menu item restores the color of the objects to their pre-drawn
colors. After an object has been recolored using the colors available
on the color palette, you may wish to change the object back to the
color in which it originally appeared in the preview box. This feature
allows you to accomplish that task by selecting the object or objects
you wish to restore and selecting Restore Color from the Goodies
menu or pressing (3-R ).

Ideal Size (3-I)

~ This menu item changes the size of the objects to their pre-drawn or
best size. After an object has been resized using the bigger or smaller
buttons, you may wish to return the object to its ideal or best size.
This feature allows you to accomplish that task by selecting the
object or objects you wish to revert and selecting Ideal Size from the
Goodies menu or pressing (3-I).
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You may also set Ideal Size in Preferences under the File menu to
indicate how you would like new objects to appear in the picture
wmdow.

In Storybook Weaver: World of Make-Believe, a number of images
will spring to an Ideal Size.

3 Fxle Edit Goodies

e By
fairy |genie gnome man

fairy godmother gnome woman
fortune teller |girl goblin
$mmmm | More Objects [ smmp ]
Delete Page

This menu item allows you to remove the current story page. When
you select Delete Page, you will see the following dialog box, which
asks you to verify that you wish to remove this page from your story.
You may not delete the title page of your document.

You are about to PERMANENTLY
remove this page.
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A deleted page cannot be retrieved. Once a page has been deleted,
the pages of your story are automatically renumbered.

Insert a Page

This menu item allows you to add a blank page before the current
story page. When you select Insert a Page, you will see the
following dialog box, which asks you to verify that you wish to add
a new page to your story. You will then be asked to select what your
new page will look like.

Insert new page before
current page?

An inserted page is added before the current story page. You may
not insert a page before the title page. Storybook Weaver: World

of Make-Believe allows you to create a maximum of fifty pages per
story. When inserting a page into your story, the pages of your story
are automatically renumbered.

Copy a Page

This menu item allows you to duplicate a previously drawn page on
to the current page. The entire page, including the current scenery
and objects in the picture window and the text, is affected. When
you select Copy a Page, you will see the following dialog box, which
asks you to enter the number of the page you wish to copy onto your
current page. The number of pages in your current story document is
indicated. If you mistakenly type a number out of that range, you
will hear a system beep. You may not copy the title page.

Copy a Page
There are 2 pages in Untitled.
Copy page to the current page.

ok _J
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Swap Page

This menu item allows you to change the order of your storybook
pages, exchanging one complete story page for the current story
page. When you select Swap Page, you will see the following dialog
box, which asks you to enter the number of the page you wish to
exchange with the current story page.

Swap Page
There are 2 pages in Untitled.
Swap page with the current page.

The dialog box reminds you of how many pages are in your

document. If you mistakenly type a number out of that range, you

will hear a system beep and return to this dialog box. You may not -
swap the title page with the current page.

Go To Page... (3-G)

This menu item allows you to go to any page in your current story
document. When you select Go To Page... or press G-G, you will see
the following dialog box, which asks you to enter the number of the
page you want:

Go To Page
There are 5 pages in Untitled.

Go to Page: [3_ |
[ ok ]

The dialog box comes up with the current page highlighted. Type the
page you want and press Return or click on the OK button. The
dialog box reminds you of how many pages are in your document. If
you mistakenly type a number out of that range, you will hear a
system beep and return to this dialog box.
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When you go to a page, the cursor will be placed in the picture
window of that page. This menu item allows you to go quickly to
any page within your story without having to use the page-turning
buttons located at the bottom of the main work screen.
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Q. How should I introduce Storybook Weaver: World of
Make-Believe to my students?

A. See the “Use in an Instructional Setting” section, beginning
on page 79. This section provides many suggestions for using
Storybook Weaver: World of Make-Believe. You will also
want to look at “A Step-by-Step Look at Storybook Weaver:
World of Make-Believe” section, beginning on page 15,
which introduces many of the program’s features.

Q. At what grade level should Storybook Weaver: World of
Make-Believe be introduced?

A. Since folktales and fairy tales offer a route to fantasy and
make-believe, Storybook Weaver: World of Make-Believe
draws on the elements of folk literature, allowing students to
explore folklore from various cultures. The product contains
a grade-level recommendation of K-6 and is intuitive enough
for primary students to master while providing many features
and flexibility that older students will find appealing.
Therefore, we encourage students in any grade level to create
storybooks using Storybook Weaver: World of Make-Believe.

Q. Should I introduce all the features before my students use
Storybook Weaver: World of Make-Believe?

A. No. Seethe “Use in an Instructional Setting” section. We
suggest introducing features gradually, as they are required,
over an extended period.

Q. How should I end a Storybook Weaver: World of Make-
Believe session?

A. Select Stop from the tool palette on the main work
screen. When you have returned to the main menu, select “7
would like to quit now.” If you plan to use another program,
close the Storybook Weaver: World of Make-Believe
Program disk, select it, and select Eject from the Disk menu.
If you plan to end all work at the computer, close the
Storybook Weaver: World of Make-Believe Program disk and
select Shut Down from the Special menu.
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Does Storybook Weaver: World of Make-Believe run on a
network?

Yes. Storybook Weaver: World of Make-Believe runs on
networks that support GS/OS System 5. You will need to
purchase a special network version to load onto the file server.
Contact MECC Membership Services for information on the
network version.

How do I make data disks?

Use Disk Accessory available under the Apple menu on the
Storybook Weaver: World of Make-Believe menu bar. The
disk will be formatted and can be used for storing Storybook
Weaver: World of Make-Believe files.

Why are some menu items gray?

Nothing is wrong. Certain menu items are not available when
objects or text have not been selected or until some other
required action is taken. For example, Bring to Front and
Send to Back on the Goodies menu are not available until you
have placed selected objects in your picture window.

Why are the buttons on the title page and the buttons on
the tool palette gray?

If the buttons on the title page and tool palette are gray,
Storybook Weaver: World of Make-Believe is in “read only”
mode. Storybook Weaver: World of Make-Believe does not
allow editing in this mode. To activate the buttons, you must
return to the main menu to make another menu selection.

What is the largest number of objects I can have on a
single page in Storybook Weaver: World of Make-Believe?

Storybook Weaver: World of Make-Believe limits the number
of objects per page to fifty. If you try to add more than fifty
objects per page, you see a dialog box warning that you

have reached the object limit.
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Q. What is the largest document size you can have in
Storybook Weaver: World of Make-Believe?

A. Storybook Weaver: World of Make-Believe documents are
limited to fifty pages. Depending on the amount and size of
the objects you have used in your document, you may run out
of memory before you reach the fifty-page limit.

Q. What Teacher Options are available with Storybook
Weaver: World of Make-Believe?

A. You can set various options by selecting Preferences on the
File menu. You can select small, large, or fancy font; the
page type you desire; whether or not moved objects are
brought to the front of other placed objects; the printed format
of your story; and how new objects will appear in the picture
window.

Q. IfI want my students to color their printed story pages,
using crayons, markers, or colored pencils, will
Storybook Weaver: World of Make-Believe print “coloring
book” pages?

A. In Storybook Weaver: World of Make-Bel:ieve, the objects are
drawn in full-color. The major part of any object is colorable,
using the colors available on the color palette. If desired, you
may select white as your scenery choice and color the objects
you place in the picture window white. This will provide a
region of each image that is colorable, using crayons, markers,
or colored pencils.
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Writing is a thinking process. For children, learning to read and write | Using Storybook
begins early in life and is ongoing, developing in concert with oral Weaver: World of

language. Make-Believe with

Storybook Weaver: World of Make-Believe provides your students Your Students
with an open-ended writing tool that allows them to discover the
writing process that best fits their writing styles. Our intent is to
provide an environment that puts students in control of their writing.
Great care has been taken to provide students with flexibility in their
approach to writing. Students can begin by creating a picture or
writing their story text. Students can also work between picture and
story as they compose and edit their storybook pages.

Storybook Weaver: World of Make-Believe encourages a process
approach to writing. In process-oriented classrooms, children learn to
write by actively engaging in writing whole and meaningful texts.
Children select their own topics, formulate ideas, compose drafts,
interact with peers, revise, edit, and publish their work for real
audiences. As the process unfolds, the writer may return to any one
of these activities at any time.

Storybook Weaver: World of Make-Believe draws on the elements of
folklore. The genre of folklore contains a wide variety of types of
tales, far more than the basic fairy tale that many of us grew up with.
Folklore contains tales that are familiar, affirming one’s own cultural
heritage, and tales that are less familiar, reflecting the heritage of
various, diverse cultures. This combination of the familiar and
unfamiliar can result in students learning more about their own
culture and learning new respect for unfamiliar cultures.

Since children possess a wide range of reading and writing skills,
Storybook Weaver: World of Make-Believe provides an introduction
to writing for some, while for others it provides a rich, creative
environment to encourage the elaboration of learned writing skills.

This section presents a variety of suggestions for incorporating
Storybook Weaver: World of Make-Believe into your classroom
writing environment. You’ll find ideas for getting started,
composing, drafting and revising, sharing and publishing,
collaborative writing, writing suggestions, storytelling, reading aloud,
connecting reading and writing, and integrating literature.

During writing, students intertwine thoughts, ideas, experiences,
pictures, and words to create an intricate story fabric. Through
writing, students discover the wholeness in their intricately woven

tapestry.
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World of Make-
Believe

With the large choice of inviting scenery and varied objects available
in Storybook Weaver: World of Make-Believe, motivating students to
write will be easy! Yet students will differ in their approach to
Storybook Weaver: World of Make-Believe. Younger students may
use the scenery and the objects to guide their writing. They may draw
their picture first and mold their story to fit the picture they have
created. Older students, with more writing experience, may come to
Storybook Weaver: World of Make-Believe with their ideas thought
through, ready to compose, then utilize Storybook Weaver: World of
Make-Believe to illustrate the ideas communicated through their
writing.

Whatever the approach, we suggest that when you introduce
Storybook Weaver: World of Make-Believe to your students, you
initially encourage the use of this product as a browsing tool. Students
need the opportunity to explore not only the interface of the product
but also the variety of scenery and objects that are available for use.

As you introduce Storybook Weaver: World of Make-Believe to your
students, you may wish to use the “Step-by-Step Look at Storybook
Weaver: World of Make-Believe” section to familiarize them with the
main work screen, scenery and object selection, and the features of
this product. Provide time for students to create pictures before you
expect them to write a story. Through this exploration, students will
generate ideas for their writing. In that way, their further experiences
with Storybook Weaver: World of Make-Believe will allow them to
focus more on writing, composing, and using the objects and scenery
to illustrate their story ideas.

Here are several prewriting suggestions that you can use with your
students as they explore Storybook Weaver: World of Make-Believe.

e Folklore comes from the oral tradition. These tales were
handed down by word of mouth generation after generation,
until they were written down, only to be retold over and over
yet again.

The game, “whisper-down-the-lane,” will give your students a
chance to think about what happens to a story as it passes from
person to person and from generation to generation. Have
your students sit in a line or circle and whisper a brief story or
anecdote from one to another. Compare the last version

with the original. Then have your student analyze the changes
at different points in the story and the reasons they might have
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occurred. Using talk as prewriting will spark your students
imaginations about story possibilities.

e From a folklorist’s point of view, a tale is re-created every
time it is told and therefore every telling is correct in its own
way. A great deal of variation is also acceptable in print
versions were authors and illustrators may also add original
twists, customize their stories for a chosen audience, or adapt
a familiar tale to an unfamiliar setting.

In order to share the richness of folklore with your students,
read folktales, fairy tales, and fables. Likewise, encourage
them to read folklore by themselves, since the more they are
exposed to other people’s writing, the more background
they’ll have for their own use. Later in this section we have
provided a sampling of children’s literature that reflects a
similar theme to that of Storybook Weaver: World of Make-
Believe.

» Every culture has produced a folklore. The study of the
folktales from various cultures will provide insights into the
beliefs of the people, their values, their life styles, and their
histories. A cross-cultural study of folk literature will help
children discover the universal qualities of humankind. Help
your students identify the recurring patterns and motifs found
in folklore.

We suggest introducing Storybook Weaver: World of Make-Believe
to your students using a guided exploration approach. This method
uses your writing curriculum as the basis of the writing tasks. As
students encounter difficulties or inquire about new Storybook
Weaver: World of Make-Believe functions, the functions are
introduced either individually or collectively. An advantage of the
“on-demand” method is that it allows you to continue your writing
curriculum and activities with as little interruption as a new piece of
technology can allow. The technology is available on a “need-to-
know” basis; that is, it is introduced at a critical moment and not
before.

Obviously, with a guided exploration approach, some students may
never inquire about certain functions or may not be aware of an
alternative and efficient method. In some cases, students may need
functions or options but never ask for them. Students may gettoa
performance plateau of user sophistication but not go beyond it.
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Dratting,
Composing, and
Revising

Additionally, you may need to repeat instructions about a Storybook
Weaver: World of Make-Believe function several times. If functions
are introduced only as students need them, several explanations may
be needed before the entire class has mastered them.

If you use a guided exploration approach, you may want to organize
writing teams or student writing pairs to assist with the dissemination
of knowledge.

Writing is a powerful instrument of thought. In the act of composing,
writers learn about themselves and their world and communicate
their insights to others.

As students begin composing or drafting their stories or writing
assignments, Storybook Weaver: World of Make-Believe can be
used in several different ways. Students may compose at the
keyboard, transcribe their handwritten work at the keyboard, or
dictate their writing to an older student, parent volunteer, or teacher.
Storybook Weaver: World of Make-Believe can be used to get ideas
down quickly.

It is at this stage of the writing process that students begin to geta
real sense of the effort and energy that goes into writing. Using the
simple word-processing features in Storybook Weaver: World of
Make-Believe, students can write readily, producing written work
that is longer, neater, and more fully developed. Through entering
and editing text, students can create a story that flows smoothly from

beginning to end.

For young students, their oral-language skills are often more
developed than their written-language skills. In their writing,
students often avoid the use of words that they can’t spell, even when
“invented” spelling is encouraged. Storybook Weaver: World of
Make-Believe’s “Spell” button allows students immediate access to
the correct spelling of any object placed in their picture window. In
this way, Storybook Weaver: World of Make-Believe encourages
students to focus on their storyline during composition and
encourages the use of their rich oral language.

One of the most frequently cited advantages of working with a word
processor is the ease with which text can be edited. Storybook
Weaver: World of Make-Believe can be used to rewrite draft
versions, add and delete words and sections of text, and organize
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paragraphs and pages. Features, such as cutting and pasting text and
page options, are available under the Edit menu or the Goodies menu.
Command Key options provide direct access to these features.

Writing is meant to be shared. Storybook Weaver: World of Make-
Believe makes publishing an easy and attractive way for students to
share their writing with others. Students can take pride in the printed
stories produced as a finished product. A student’s printed copy of a
Storybook Weaver: World of Make-Believe document will appear as
it does in the picture and story window on the main work screen.

Storybook Weaver: World of Make-Believe’s print options allow for
one or two story pages per printed page. A big-book format is also
available for creating books for whole-class sharing. Stories may be
printed in gray-scale or color on an ImageWriter II or in gray-scale
on a LaserWriter printer.

Toward the end of the writing session, you can come together as a
group to share—to read and celebrate completed texts as well as texts
in progress. Offer praise and support for the efforts and
accomplishments of your writers.

The purpose of one-to-one sharing is simply to share a good story.
Children read their stories to one other person whose job it is simply
to understand what has been written. The listener asks questions,
makes comments, and offers support and encouragement.

In whole-class sharing, children can share what their partners had
written with the class. The listener must understand and remember
enough of the details to tell the other children about the story.

You can help the children share their writing by binding stories into
books to be used during independent reading.

You can share writing with the larger community. This introduces
children to the concept of audience.

Here are some other suggestions for story sharing:

e Designate a child as the author of the day. Bring a
microphone and podium into the classroom for students to
read a story aloud to the class. The microphone and podium
add a professional feel to reading that students enjoy. If a
microphone and podium are not available, designate an
author’s chair for story sharing. Be sure to invite other
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Binding a Story
into a Book

classes, your building principal, parents, and others to share
in these story sessions.

o Use Storybook Weaver: World of Make-Believe’s “Choose a
story to read” option from the main menu to share writing.

In a one-computer classroom, you can attach an LCD (liquid
crystal display) to the computer to project the story on a large
screen. Then use the page-turning buttons to read the story
text. If you are writing in a computer lab environment, load
completed stories and have your class rotate through the lab,
reading a story at each computer workstation. Selecting
“Choose a story to read” from the main menu protects the
author from having unauthorized editing done to the story.

» Using the big book printed format available under Preferences
on the File menu, create big books to share during whole-
class reading times.

» Bind student stories into books. Using Storybook
Weaver: World of Make-Believe, students’ stories can be
printed for them to keep and read over and over again. While
there are many techniques for binding books, a simple
procedure is outlined on this page.

« Bind student stories into one large class book that can be
placed in your classroom, building library, or media center. A
collection of class books available for parents to enjoy during
conferences and school visits is an exciting way to share your
student’s writing.

To prepare a story for binding, choose your printed page format by
selectmg one or two story pages per printer-page or big-book format.
This is set under Preferences on the File menu. Print the story by
selecting “Choose a story to print” from the main menu of Storybook
Weaver: World of Make-Believe.

Once the story has been printed, assemble the pages by placing each
page in the story sequence. If the story has been printed on form-feed
paper, separate each page before binding.

Create an endpaper by placing a heavy piece of colored paper
(8 1/2" x 11") in the front and the back of the assembled book pages.

Staple the pages together along the binding edge. This will create the
book spine. You may prefer to sew the book pages together at the
spine using a running stitch on a sewing machine.
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Make book covers by gluing two 6" x 9" cardboard rectangles to a
single sheet of wallpaper. Fold the wallpaper over the inner edges of
the cardboard and secure with glue. (Dry mount tissue and fabric also
make nice book covers.)

Then glue the endpaper to the inside front cover of the book. Do the
same with the endpaper at the back of the book. Your book is
finished!

Add a copy of the bound books to a classroom library and send a
copy to the central library or media center.

Collaborative writing is an activity that sparks children’s talk about
writing. Adults often co-author stories, articles, and books. Children
should be afforded the same opportunity for co-authorship.

Collaborative writing has a unique application within a computer
environment. Children can merge their ideas into one coherent-
looking text and can make revisions without having to recopy the
entire text. Collaboration makes good use of a limited number of
computers in the classroom or school. And children enjoy occasional
social experiences as they spend time discussing writing in a
computerized writing class.

Collaborative writing involves students interacting with other
students. Throughout the writing process, students suggest and revise
their story from the perspective of a writer and a reader. Peer
interaction provides the feedback necessary to revise.

Storybook Weaver: World of Make-Believe provides a vehicle for
students to write collaboratively. Students can work together to
generate ideas, compose and revise, and gain feedback and share their
writing. Students’ initial exposure to collaborative writing may
involve helping each other with their writing by being a good listener
and trying to understand the writer’s intention. The following
suggestions provide ways for students to write collaboratively.
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Using student groups to generate ideas:

* Brainstorming is done either with a partner or in a resource
group. The list of ideas becomes a stimulus to help students
choose a topic.

* Students may decide on a topic individually and then
work collaboratively to organize the story. This might be
done using the technique called “scripting,” whereby students
take turns discussing one another’s stories. Students address
such aspects as what ideas to include, how to start the story,
and the story sequence.

Using student groups to compose and revise:

*  Once the student has chosen a topic and organized the story,
the partner continues to be a resource during this process as
students check with one another about the clarity and
communication of their ideas.

* Students may often print two story copies, one for their own
proofreading and the other for their writing partner to edit.
These suggestions become the basis for revisions.

Using student groups to gain feedback and share writing:
e Students may share their finished writing with their writing
partner by reading aloud or reading printed storybooks.
The writing partners provide feedback about the story and
how it communicated the author’s message.

Your students might also enjoy round-robin writing. There are many
ways to structure such an activity. One approach is to have each
student add a sentence or page to a composition that you or another
student has begun.

Storybook Weaver: World of Make-Believe can also be used for
cross-age collaborative writing as younger students work with older
students to create a story. In this environment, younger students
develop verbal communication skills, learn computer skills, and use
their imaginations. Older students develop a sense of responsibility
for providing effective learning experiences for younger children
while developing their skills in organization.

Collaborative writing can be a way of learning more about what

happens in the writing process as children talk over their plans, ideas,

and decisions with others. For those students who enjoy the team

experience and the ideas generated in a group, collaborative writing

has many possibilities. -_
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The theme of Storybook Weaver: World of Make-Believe is closely
tied to folklore. We believe that one way of coming to know about
many cultures is through folktales. Folktales are timeless in their
appeal and transmit universal themes that speak to audiences of all
ages and backgrounds. At the same time, folktales are grounded in
particular cultures. Folklore is a mirror, reflecting the values and
traditions of a culture, as well as a window, revealing the values and
traditions of less familiar cultures.

Folktales and fairy tales also offer a route to fantasy and adventure.
The world of “once upon a time” offers children a wonderful release
from their earthbound world of rules and limits. It is through such
stories that children can take off on far-flung fantasy where anything
can happen and often does.

Students learn to write by writing. The specific purposes for writing
vary widely, from discovering the writer’s own feelings to
persuading others to a course of action, recreating experiences
imaginatively, reporting the results of observations, and more.
Writing assignments should reflect this range of purposes.

Here are some suggestions for using Storybook Weaver: World of
Make-Believe with your students:

. Folktales have a variety of well-known themes and recurring
patterns. Again and again, folktales spin stories of the young,
independent adventurer, face to face with danger that
demands great courage. They are stories of good triumphing
over evil; about young against old; the weak versus the
strong. Encourage your students to explore the recurring
patterns that connect folktales from different countries. As
they write their own folktales, invite them to discover ways
to incorporate these themes and patterns in their own writing.

. Folktales fall into varied groups. Cwmnulative or repetitional
tales are the simplest of all stories. Their charm lies in their
simple plots and great rhythm, with each episode following
another neatly and logically in a pattern of cadenced
repetition. One of the classic cumulative tales is
“The House That Jack Built.” Have your students create a
cumulative tale, authoring a refrain that is repeated
throughout the story.

Storybook Weaver: World of Make-Believe
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e Another type of folktale is the ralking beast tale. These are the
tales in which animals talk, sometimes with human beings but
most often with other animals. These talking beast tales, in which
the creatures talk every bit as wisely or foolishly as humans,
generally teach a lesson. Have your students compose a talking
beast story. Have students identify the lesson learned through the
animals actions.

e Some folktales are “why” or pourquoz > stories that explain
certain animal features, the origin of certain natural features, or
how humans and their customs came to be. Tales, such as “Why
the Bear Is Stumpy-Tailed” are fun for children to learn. Your
students will enjoy creating their own “why” stories.

» There are many folktales that involve magic. These tales include
such things as three wishes, some kind of magic or spell, or
animals or people with special powers. Folktales and fairy tales
also abound with magic brews and incantations to bring forth their
magical properties. Have your students plan a magic brew, listing
the ingredients to be used. What effect would this brew have on
the user? Have students compose the incantation to make this
brew effective.

In addition to the various themes, recurring patterns, and types of
folktales, your students will enjoy exploring other writing purposes
with a focus on folklore.

» Have your students read at least four versions of a folktale or
fairytale. As they read, have them note the opening sentence, how
personalities are developed, the choice of language, and the
sequence of events. Ask them to combine some elements of each
version to create another version of the tale.

» Familiar folktales and fairytales appear in many cultures. In fact,
there are over 400 versions of the Cinderella tale found
throughout the world. Have your students conduct some research
comparing several versions of a similiar tale. Ask them to
identify the country of origin, the name of the main character, the
tasks to be accomplished, the wishers, who helped to accomplish
the tasks, and so forth.

» Have your students assume the role of an investigative reporter.
Interview a character in a folktale or fairytale. Generate a list of
questions to ask and then report their story.
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» Ask students to assume the personality of the main story
character. For example, have them describe how they would feel
if they were Cinderella and their step-sisters went to the ball while
they were left at home.

« Use a wall map or globe to locate the countries from which the
folktale or fairytale originated. Have your students explain how
the stories from so many different parts of the world could be so
similiar.

» Ask students to think about the feelings and ideas manifested in
many of the folktales and fairytales: sibling rivalry, growing up
and leaving the family, the power of love, the importance or
unimportance of materials things. Ask your students to examine
these themes in modern life.

» Use newspaper writing to speculate about the lives of the
characters in folktales and fairytales. Have your students write a
wedding announcement for two characters, an advertisement for a
house, a classified ad for a lost-and-found column, or a editorial
expressing their displeasure about the actions of a character.

» Have your students describe the reactions that might be expected
if they suddenly found themselves in the world of a folk or
fairytale character from long ago.

» Have your students select their favorite folktale or fairytale villian
to transform into a hero or heroine by telling their side of the

story.

» How have folktales been passed from one generation to another?
When were the first folktales and fairytales written down? Who
were some of the collectors of folktales? Have students write a
historical biography of these collectors.

» The events that happened in a particular tale might be different in
various versions. Your students can compare several story
sequences and determine which version they like best. Write a
different beginning for the story, another ending, or a sequel.

We view writing as an instrument of thought and learning across the
curriculum and in the world beyond school.
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Story-Starters

Time and place are established quickly in the folktale. Time is always
past and often described by such conventional terms as “Once upon a
time” or “In the first old time.” The setting of the folktale is not
specific, but in some faraway land, in a cottage in the woods, or in a
beautiful palace.

The structure of the folktale, with its quick introduction, economy of
incident, and logical and brief conclusion, maintains interest through
suspense and repetition. Because the storyteller has to keep the
attention of the audience, each episode must contribute to the theme
of the story.

Story-starters can be used to suggest a writing topic to students. They
plant the seed of a new story idea for the writer. A story starter may
consist of an intriguing picture, a sentence in the story window, or
both.

Before beginning to write, students may address such questions as:

e who is going to be in the story;

» where will the story take place;

« when will it happen;

* what will happen first in the story;
* how will your story end.

We have compiled a sampling of story-starters that can be used to
engage your students in writing. Our intent is to provide some
suggestions for interesting or intriguing uses of the objects and
scenery available in Storybook Weaver: World of Make-Believe.
The possibility for story-starters is limited only by imagination.

A Tong time ago, in a certain place in Africa, a sm]l
village lay across the river and half of a dag S journey
from a city where a great king lived.
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ln the palace of a farawag land ther'e lived a beautlful
young maiden and a beast.

Once upon a t1me a young glrl named Gold1 cks came to
visit the home of the three bears. She knew the three
bears for some years before Goldilocks had come to the
bears cottage when they were away.
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for the big surprise.

In times long gone, saﬂors readled their vesse1 for the
strong winds, rough waters, and salty sea air.

in the depths of the ocean there is a magwl world just
waiting to be discovered.
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Oral interpretation through storytelling can help children explore the
rich language of folklore that reflects its oral origins. Storytelling in
the classroom offers natural opportunities for children to grow as
language users. Storytelling extends an invitation to read, and a
natural progression from hearing, reading, and telling stories is the
writing of original stories.

From kindergarten through the intermediate grades, storytelling can
be used as a tool to reinforce comprehension skills, encourage
creativity, and stimulate interest in independent reading and writing.
Here are a few suggestions for encouraging storytelling through the
use of Storybook Weaver: World of Make-Believe.

» Drawing is an important way to tell a story, especially for
the young child. Have students create a story to tell in
pictures. A wordless picture book can be created using the
scenery and objects available in Storybook Weaver: World
of Make-Believe and omitting the story text. Students can
select the “Choose a story to read” option from the main
menu to share their pictures as they tell the story.

» Use a tape recorder to encourage students to share their
stories with others. Use the tape in conjunction with
the “Choose a story to read” menu option or provide a
printed version of the story for students as they listen to the
taped story.

» Let writing become the basis for oral storytelling. Using a
story the student has written, have them practice the story
until they are comfortable enough that they can tell the story
to a group. Then schedule some storytelling sessions,
allowing students to use props, if desired, to make their
written stories come alive through oral language.

» Round-robin storytelling can be a written as well as an oral
experience. Have one student start a story by writing one
page. The next student continues the story, adding the next
page. This activity works best in small groups so that the
waiting time for the story to be written and shared is
relatively short. To create a purely nonsensical tale, each
writer should begin on a new page that contains only the last
line of the previous writer’s portion. That way, none of the
writers knows what the others have written prior to the last
line. The illogical story makes for hilarious oral reading and
sharing.
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Reading Aloud

Connecting Reading
and Writing

* Finally, encourage children to retell stories by modeling
storytelling for them. Choose a favorite story to tell to your
class. At the conclusion of the story, have students create
their own rendition of the story you have shared.

Storytelling permits children to become active participants in the
creation of language and allows book language to serve as a model
for their own.

One of the easiest and most effective methods of getting children
interested in reading good books is to read aloud to them. While we
often think of reading aloud as an activity associated with books in
print, Storybook Weaver: World of Make-Believe provides a forum
for reading aloud in an electronic environment.

Selecting “Choose a story to read” from the main menu allows you
to engage in read-aloud story-sharing sessions using those stories
created with Storybook Weaver: World of Make-Believe. Since this
option allows no editing, the page-turning buttons allow you to turn
the page to continue the story, much like turning the pages of a book.

As students listen to the stories, the reading and writing connection is
established.

Writing is considered part of reading instruction. When children
write about topics of interest to them, writing becomes an integral
part of communication. Children learn about language by using it
themselves in a meaningful way. By reading and revising their own
writing, by reading and responding to other children’s writing, and
by sharing their writing with peers, children begin to believe in
themselves as writers as well as readers.

When you watch students writing, you are watching reading. While
composing, children read continually. They read to savor what they
have written. They read to regain momentum. They read to edit.
Finally, they read aloud to share what they have written.
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For children, literature provides a model for comparison with
experienced writers. As children read, they are reading the creative
writing of others. In turn, when children write their own way, they
gain experience with the decisions an author has to make.

Literature provides a model for writers as well as a springboard for
children’s writing. Books can offer a bridge to understanding that
other people have problems, feelings, and experiences like their own.
Some books provide themes to explore further; others lend
themselves to sequels that enable young readers and writers to
explore what happened “after” the end of the book. Still others
encourage children to write about similar subjects: a journey, a
place, or an interesting person.

We believe that in order to teach writing, you must surround your
students with literature. Therefore, we have compiled a sampling of
folk literature that appear in various bibliographical listings for
young children. These books have been selected because they reflect
themes or settings that can be used to extend writing with Storybook
Weaver: World of Make-Believe.

For each book listed, we have included the complete title, the author
(or authors), illustrator, publisher, copyright date, and an annotation.
Annotations are brief in order to give you just an inkling of each
book’s content.

Equal attention was given to retain those timeless books that have
been favorites of generations of children and to include
contemporary books that are well on their way to becoming classics
in their own time.

Recommending one version of a folktale or fairytale is difficult. We
acknowledge that the richness of a tale comes from the meaning of
many versions. While not every book will appeal to every child, this
listing serves as a starting point as you weave literature into your
writing classroom. It is not intended to be exhaustive. We
encourage you to consult your school or local library for additional
recommendations.

By weaving together the arts of reading, writing, speaking, listening,
and thinking, Storybook Weaver: World of Make-Believe provides
students with the opportunity to make literature their own through
writing.
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A Story, A Story
Gail E. Haley
Atheneum, 1970
Caldecott Medal
One of the African tales of Anansi the Spider. In this episode
he brings to earth all the stories owned by the Sky God.

Anansi the Spider
Gerald McDermott
Holt, 1972
In this wittily illustrated story about Anansi, the West African
spider-hero, he has six sons who combine their talents to save
their father.

Baby Rattlesnake
Adapted by Lynn Moroney
Veg Reisberg
Children’s Book Press, 1989
Te Ata, a Chickasaw Indian, tells the tale of “Baby
Rattlesnake.” This is a Native American tale of family love—
in this case a family of rattlesnakes.

Beauty and the Beast
Retold and Hlustrated by Jan Brett
Houghton Mifflin, 1989
Through her great capacity to love, a kind and beautiful maid
releases a handsome prince from the spell which made him an
ugly beast.

Bringing the Rain to Kapiti Plain: A Nandi Tale
Verna Aaredema
Illustrated by Beatriz Vidal
Dial, 1981
A cumulative story from East Africa about how Ki-pat
brought the rain to the “dry, oh so dry, Kapiti Plain.”
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The Crane Wife
Sumiko Yagawa
Illustrated by Suekichi Akaba
Morrow, 1981
New York Times Best Illustrated Book
Translated by Katherine Paterson, this is a beautiful version
of a favorite, heartbreaking Japanese folktale. It tells about
the farmer who marries a beautiful and mysterious stranger.
She weaves fine cloth and warns him never to watch her, and
for good reason: she is really the crane he once rescued
from death, and if he sees her she must leave him.

East of the Sun and West of the Moon
Mercer Mayer
Macmillan, 1980
The Moon, Father Forest, Great Fish of the Sea, and North
Wild help a maiden rescue her true love from a troll princess
in a faraway kingdom.

Emily and the Enchanted Frog
Helen V. Griffith
Illustrated by Susan Condie Lamb
Greenwillow, 1989
Children's Choices for 1990
In these three stories, indomitable Emily kisses an enchanted
frog and then has to kiss a lot of other frogs to find another
that’s enchanted, meets an elf and gets three wishes, and
meets two unusual mermaids.

Eye of the Needle
Retold by Teri Sloat
Dutton Children’s Books, 1990
Sent out by his grandmother to find food, Amik consumes a
series of animals of ever-increasing size and brings back
more than he thinks. This story is based on a Yupik Eskimo
tale.

The Frog Prince
Retold by Jan Ormerod and David Lloyd
Lothrop, Lee & Shepard Books, 1990
As payment for retrieving the princess’s ball, the frog exacts
a promise which the princess is reluctant to fulfill.
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The Gift of the Sacred Dog
Paul Goble
Macmillan, 1984
In response to an Indian boy’s prayer for help for his hungry
people, the Great Spirit sends the gift of the Sacred Dogs—
horses—which enable the tribe to hunt for buffalo.

Goldilocks and the Three Bears
Retold and Illustrated by Jan Brett
G.P. Putnam’s Sons, 1987
Lost in the woods, a tired and hungry girl finds the house of
the three bears where she helps herself to food and goes to
sleep.

The Happy Prince
Oscar Wilde
Ilustrated by Ed Young
Simon & Schuster, 1989
Children’s Choices for 1990
This story of self-sacrifice and devotion has universal appeal.

Kiss a Frog! Jokes About Fairy Tales, Knights, and Dragons
Rick Walton and Ann Walton
Illustrated by Joan Hanson
Lemer, 1989
Children’s Choices for 1990
Puns and word play highlight this collection of jokes about
fairy tales, knights, and dragons.

The Legend of the Bluebonnet
Retold by Tomie dePaola
G.P. Putnam’s Sons, 1983
A retelling of the Commanche Indian legend of how a little
girl’s sacrifice brought the flower called bluebonnet to Texas.

Liang and the Magic Paintbrush
Demi
Holt, Rinehart, and Winston, 1980
A poor boy who longs to paint is given a magic brush that
brings to life whatever he pictures.
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Lon Po Po
Retold by Ed Young
Philomel, 1989
Caldecott Medal
Children’s Choices for 1990
This Chinese version of “Little Red Riding Hood” tells the
story of three children who trick the wolf and save
themselves.

Many Moons
James Thurber
Illustrated by Marc Simont
Harcourt Brace Jovanovich, 1990
Though many try, only one court jester is able to fulfill
Princess Lenore’s wish for the moon.

The Mitten
Jan Brett
Putnam, 1989
A Ukrainian folktale in which several animals sleep snugly
in Nicki’s lost mitten until the bear sneezes.

The Monkey and the Crocodile
Paul Galdone
Houghton Mifflin, 1969
A retelling of one of the Indian fables relating to the former
births of Buddha in which as a monkey he manages to outwit
the crocodile who decides to capture him.

Mufaro’s Beautiful Daughters: An African Tale
John Steptoe
Lothrop, 1987
Caldecott Honor Book
A West African tale about Mufaro’s two beautiful but totally
different daughters—Manyara, who is ambitious and mean,
and Nyasha, who is kind and helpful.
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My Father’s Dragon
Ruth Stiles Gannet
Illustrated by Ruth Chrisman Gannett
Random House, 1948
Newbery Honor Book
The narrator’s father, Elmer Elevator, sets out to rescue a baby
dragon from the Wild Island. He uses his wit and imagination
to outwit the lions, tigers, and other creatures on Wild Island.

One Fine Day
Nonny Hogrogrian
Macmillan, 1971
Caldecott Medal
In this wittily illustrated Armenian folktale, a sly fox steals
milk from an old woman. She gets her revenge and his tail.

The People Could Fly
Virginia Hamilton
Ilustrated by Leo and Diane Dillon
Knopf, 1985
A retelling of twenty-four black American folktales by a
distinguished contemporary writer. There are animal stories,
supernatural tales, and slave tales of freedom.

Princess Furball
Retold by Charolotte Huck
Ilustrated by Anita Lobel
Greenwillow, 1989
Teacher’s Choices for 1990
A princess in a coat of a thousand furs hides her identity from
a king who falls in love with her.

Puss in Boots
Charles Perrault
Translated by Malcolm Arthur
Ilustrated by Fred Marcellino
Farrar, Straus and Co., 1990
A translation of the French fairy tale about the cat who, with
a sack and a pair of boots, gained a fortune for his master.
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The Riddle of the Drum: A Tale from Tizapan, Mexico

Verna Aardema

Illustrated by Tony Chen

Four Winds Press, 1979

Anxious to keep his daughter from marrying, a king
announces that no man may marry his daughter unless he
guesses the kind of leather used in a drum made by a
wizard.

Saint George and the Dragon

Margaret Hodges

Illustrated by Trina Schart Hyman

Little Brown, 1984

Caldecott Medal

New York Times Best Illustrated Book

This is a retelling of Saint George’s three-day battle with
the dragon.

Sleeping Ugly

Jane Yolen

Illustrated by Diane Stanley

Coward, McCann & Geoghegan, 1981

When beautiful Princess Miserella, Plain Jane, and a fairy
fall under a sleeping spell, a prince undoes the spell in a
surprising way.

Stone Soup

Marcia Brown

Scribners, 1947

Caldecott Honor Book

Three tired and hungry soldiers are returning from battle.
They approach a village of people who hide their food and
close their doors. No one offers help to the soldiers, but the
soldiers have a plan. They build a fire under a large pot of
water, then place stones inside. Curious townspeople come to
see the preparation of this strange stone soup, which in the end
is full of vegetables and meats.
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Swan Lake
Mark Helprin
Illustrated by Chris Van Allsburg
Houghton Mifflin, 1989
A young prince and his beloved Odette struggle to protect
themselves and their infant daughter from the evil Von
Rothbart in this adaptation of the classic ballet.

The Tales of Uncle Remus: The Adventures of Brer Rabbit
Julius Lester
Ilustrated by Jerry Pinkney
Dial, 1987
A set of Brer Rabbit stories retold in a contemporary tone.

The True Story of the Three Little Pigs
Jon Scieszka
Illustrated by Lane Smith
Viking Kestrel, 1989
The wolf gives his own outlandish version of what really
happened when he tangled with the three little pigs.

The Whipping Boy
Sid Fleischman
Greenwillow, 1986
Newbery Award
The brattish medieval prince is too spoiled ever to be spanked,
so the king regularly vents his anger on Jeremy, a peasant
“whipping boy.” When circumstances lead the two boys to
reverse roles, each learns much about friendship and sacrifice.

Why Mosquitoes Buzz in People’s Ears
Verna Aardema
Ilustrated by Leo and Diane Dillon
Dial Press, 1975
Caldecott Medal
When King Lion calls a tribal council to see why Mother
Owl doesn’t wake the Sun, he finds a chain of blame sent
from monkey to crow to rabbit to python to iguana to
mosquito.
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Teachers are faced with the tremendous task of preparing today’s
students for tomorrow’s world—a world characterized by change in
an information-rich environment. Thinking skills are at the heart of
this thriving, changing environment, for these are the behaviors
students must practice in school and continue to apply for the rest of
their lives.

It wasn’t long ago that thinking skills were considered exclusive to
gifted and enrichment classes. Today, however, thinking skills are
viewed as an essential component of the total school curriculum.
Developing these skills is the goal of each individual discipline.
Many educators have, in fact, come to view thinking skills as perhaps
the most basic of the basic skills because they facilitate the
acquisition of all other learning.

At MECC, we view computer software as a vehicle for fostering
students’ thinking. Our products are curriculum-based, with thinking
skills as a thread within subject areas. This provides an environment
with many opportunities for teachers to highlight and reinforce
thinking skills.

We believe teachers play a critical role in determining the classroom
environment for thinking. Naturally, many teachers have taught
thinking skills and will continue to do so using a variety of strategies.
Our commitment is to provide teachers with the materials that help
them do their job well: high-quality software that promotes the
application of thinking skills.

Our approach to thinking skills reflects what both research and
effective classroom practice has shown. That is, the approach that is
most effective and appeals to most teachers is one that infuses
thinking skills into existing content areas. Educators have told us
they are interested in thinking skills as a method used in the
instruction of a topic, not as a subject. By infusing thinking skills
into existing content areas, MECC products integrate easily into
teachers’ curricula while providing a rich environment for students to
practice skillful thinking. We strive to meet the challenge teachers
face in promoting the skills that students need.
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If schools are to integrate the teaching of thinking with regular
academic instruction, they need to know what aspects of thinking to
teach. After exploring the research that has been done in the area of
thinking skills, MECC has chosen as a base the Dimensions of
Thinking framework, published in 1988 by the Association of
Supervision and Curriculum Development (ASCD). We chose this
framework because it pulls together research and models from a
variety of sources and brings the theory to the classroom level,
applying it to that environment. In addition to knowing the subject
matter that is covered, teachers now can see the specific thinking
skills that are challenged within a product.

This section highlights ways in which teachers can use Storybook
Weaver: World of Make-Believe to promote thinking skills with
their students. The following pages provide examples of how
Storybook Weaver: World of Make-Believe relates to the ASCD
core thinking skills framework. Although only one thinking skill per
category is correlated to a specific part of the product, each skill can
be practiced on many levels and in many aspects of the product.

We realize the importance of thinking skills in the curriculum. We
believe it is essential that students be taught thinking skills so that
they have the tools to understand the past, deal with the present, and
prepare for the future. We are confident that you will find Storybook
Weaver: World of Make-Believe of considerable value in your
classroom as you foster student thinking.
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A Framework for Thinking

The components used in thinking are referred to as core thinking skills. This framework

defines those skills that appear in the repertoire of the model learner. Each skill selected is
documented in research as important to learning or thinking, is teachable, and is valued by
educators as important for students to learn.

The core skills of the ASCD framework are listed and defined below with examples of
applications within Storybook Weaver: World of Make-Believe. The skills are neither discrete nor
hierarchical. In fact, individual skills draw on other skills and can be used repeatedly in the
thinking process. The selected examples are not exhaustive but highlight ways in which these
thinking skills are used in Storybook Weaver: World of Make-Believe.

Source: Dimensions of Thinking, Association for Supervision and Curriculum Development (ASCD), 1988.

Definition of Core Core Thinking Storybook Weaver:
Thinking Skills Categories Skills Components World of Make-Believe
Application
Focusing Skills allow Focusing Skills Prewriting activities help
students to attend to selected * Defining Problems students define their writing
pieces of information and « Setting Goals tasks. In the writing process,
ignore others. Focusing students define their audience
occurs when students sense a and write with a purpose.
problem, an issue, or a lack of Using Storybook Weaver:
meaning. World of Make-Believe,
students determine the writing
process that best fits their
writing style.

Information-Gathering Skills
involve obtaining information

Information-Gathering Skills
* Observing

As students select the topic
for their story writing, they

and clarifying issues and * Formulating Questions must focus on questions such

meanings through inquiry. as who is going to be in the
story; where will the story
take place; when will it
happen; what will be the
sequence of events in the
story.

Remembering Skills are Remembering Skills Storybook Weaver: World of

those activities or strategies » Encoding Make-Believe draws from the

that students consciously » Recalling elements of folk literature,

engage in to store and retrieve
information from long-term
memory. Activating prior
knowledge falls under this

category.

allowing students to learn
about various cultures. In
writing with Storybook
Weaver: World of Make-
Believe, students draw from
their previous experiences as
they develop their story ideas.
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Definition of Core Core Thinkin Storybook Weaver:
Thinking Skills Categories Skills Componeﬁts World of Make-Believe
Application
Organizing Skills are used Organizing Skills Throughout the writing
to arrange information so ¢ Comparing process, Storybook Weaver:
that it can be understood or * Classifying World of Make-Believe
presented more effectively. * Ordering affords students the .

« Representing opportunity to represent their
writing through pictures. The
pictures they compose
communicate their story
ideas to their audience.

Analyzing Skills are used to | Analyzing Skills Editing, revising, and proof-
clarify existing information * Identifying Attributes reading are tasks that provide
by examining parts and and Components opportunities fgr students to
relationships. Through + Identifying Relationships identify errors in their writing.
analysis, students identify and Patterns The continuous reading that
and distinguish components, * Identifying Main Ideas takes place as students write
attributes, claims, * Identifying Errors helps them to refine their
assumptions, or reasoning. written communication.
Generating Skills involve Generating Skills As Stuglf:nts progress through
using the students’ prior e Inferring the writing process, they
knowledge to add information | ¢ Predicting elaborate on ideas generated in
beyond what is given. + Elaborating prewriting and drafting stages.
Connections between new Using Storybook Weaver:
ideas and prior knowledge are World of Make-Believe,
made as new information and students can elaborate on their
ideas are recast into new writing through the pictures
structures. they create as an
accompaniment to their text.
Integrating Skills involve Integrating Skills Throughout the writing
putting together the relevant o Summarizing process, students restructure
parts or aspects of a * Restructuring their story, integrating

solution, understanding,
principle, or composition
and incorporating this
integrated information into
a new understanding.

feedback from peers and
teachers. As students share
their writing with others, they
gain experience important to
their development as writers.

Evaluating Skills involve
assessing the reasonableness
and quality of ideas.

Evaluating Skills
* Establishing Criteria
* Verifying

All writing sessions should
include opportunities for
students to share their writing
with others. With Storybook
Weaver: World of Make-
Believe, students may select
“Choose a story to read” to
share electronic storybooks
with their classmates.

106




Storybook Weaver: World of Make-Believe

The MECC team responsible for the development of Storybook Credits
Weaver: World of Make-Believe includes Charolyn Kapplinger,
Patricia Korn, and Jean Sharp. Additional support was provided by
John Krenz, and Brian Nesse.

The development team greatly benefited from the preliminary
research and planning completed by the Language Arts Team,
including Sheila Dols, Dave Duffee, and Michael Palmquist.

MECC extends a special thanks to the following educators and their
students for their assistance in the development of this product:

Kathe Herr

Fourth-, fifth-, and sixth-grade students
Far West School

Wheatland School District

Beale AFB, California

Jan Minnich

Second-, third-, fourth-, and fifth-grade students
Del Rio Elementary School

Chino Valley, Arizona

Barbra Stoddard

Bill Thomas

Second- and third-grade students
Falls Church City Schools

Falls Church, Virginia

Peter Tri

Fifth-grade students
Northrop Elementary School
Thief River Falls, Minnesota

Special thanks to Eilenne Boder, Coordinator of Children’s Services,
Ramsey County Libraries for reviewing the literature connection.

TO THE READER:

MECC has made every effort to ensure the instructional and technical quality of
this courseware package. Your comments—as user or reviewer—are valued and
will be included in any future revision of the product. Please address comments to:

MECC Software Development

3490 Lexington Avenue North
St. Paul, MN 55126-8097
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Scenery Choices You can choose from a variety of colors and scenes for your story
scenery. Six background colors and six foreground colors can be
interchanged to create 36 color combinations. Six background scenes
and six foreground scenes can be interchanged to create 36 scene
combinations. Colors and scenes may be intermixed to create 72
scenery combinations.

The chart below shows the options available when you select the
scenery button from the tool palette.

Scenery Choices
Colors Scenes
White Woods
Aqua Hill
Backgrounds Blue Roots
Brown Peaks
Grey Green
Black Canyon
White Path
Foregrounds e Pl
Brown Sea
Forest Ravine
Black Sand
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The objects available for placement in the picture window are Object Choices
available by selecting “Objects” from the main work screen of
Storybook Weaver: World of Make-Believe. Over 500 objects are
sorted into eight categories. The chart below lists the categories and
objects available in Storybook Weaver: World of Make-Believe.
Nine objects are available at any given time on the objects-selection
screen. You may, however, scroll through the entire list of objects
available in a given category by clicking on the arrows that appear
beneath the object-selection boxes. The last object displayed on a
given selection screen is underscored in the list below.

Category Name Objects Available

.iti People (Position) | Arabian prince
peop baby

baby crawling
baby sitting
baby sleeping
boy climbing
boy crawling
boy crouching

boy leaping
boy listening
boy reaching
boy resting
boy riding
boy running
boy seated
boy sitting

boy standing
boy stretching
boy walking
canoeist

chief
drummer
Dutch boy
Dutch girl
girl climbing
girl kneeling

girl leaping
girl reaching
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Category Name Objects Available
girl resting

girl riding

girl running

girl seated

girl sitting

girl stretching
girl walking
grandma
grandma seated
grandma walking
grandpa seated
grandpa sitting
grandpa walking
hunter

man bending
man crouching
man gazing
man hurrying
man jumping
man kneeling
man leaping
man lifting

man reaching
man riding

man running
man seated

man sitting

man standing
man telling

man walking
man with basket
passenger
peasant

shiek
townsperson
villager

weaver

woman and baby
woman hurrying
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Category

Objects Available

woman kneeling
woman leaping
woman reaching
woman riding
woman running
woman seated
woman sitting
woman standing
woman stooping
woman telling
woman walking

People
(Storybook
Characters)

Anansi

Baba Yaga
baker

boy

brownie boy
brownie girl
climber
coachman
craftsman
Cupid
cyclops
damsel
daydreamer
dwarf man
dwarf woman
elf boy

elf girl

fai id
fairy

fairy godmother
fortune teller
genie

giant

girl

gnome man
gnome woman
goblin

hero

heroine
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Category

Objects Available

hobbit
hooded girl
Iktomi
jester

king

knight
leprechaun
magician
mermaid
merman
minstrel
orge man
orge woman
peasant girl
piper
pirate

pixie
prince
princess
queen

red fairy
seamstress
shepherd
star maiden
fomten
tree-being
troll

Viking
warrior man
warrior woman
waterbaby
witch
wizard
woodcutter

Animals

badger
bat

bear
beaver
buffalo
butterfly
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Category Name Objects Available

camel
cat
chipmunk
cobra
coyote
crab
crane
crocodile
crow
deer
dolphin
donkey
eagle
elephant
fawn
fish

fox

frog
giraffe
goat
£00s¢
gorilla
hawk
hedgehog
horse
husky
hyena
iguana
kangaroo
leopard
lion
lizard
lobster
macaw
monkey
moose
mountain goat
mouse
octopus
opossum
owl
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Category

Objects Available

ox
peacock
polar bear
prairie dog
rabbit
raccoon
rattlesnake
reindeer
rhinocerous
rooster

sea horse
sea turtle
seal

skunk
songbird
starfish
swan

tiger
tortoise
toucan
tropical fish
water buffalo
weasel
whale

wolf

Animals

ant

baby dragon
bear

beast

bee

bird

bunny

calf

cat

chick
Chinese dragon
cow

dog
dragon
dragonfly
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Category Name Objects Available

goose
grasshopper
griffin
hedgehog
hen

lamb

mole
monkey
mouse

owl

p1g

rat

rooster

sca serpent
skunk
snail

snake
spider
squirrel
unicorn
walrus
winged horse
wolf

apple
’Esu;’f:! Nature banana tree
beanstalk
beaver dam
beehive
boulder
burrow
bush
cabbage

cactus
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Category Name Objects Available
cattails
cave
cloud
clover
coral
corn
daisies
dead tree
cgg

fern
field

fire
flames
flower
fruit tree
gnarled tree
grass
haystack
hedge
hill
iceberg
island
leaves
lightning
lily pads
log

moon
mountain
mushrooms
nest

palm tree
pebbles
pine tree
plant

privet
puddle
pumpkin

rainbow
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Category

Name

Objects Available

rice plant
rose

shell
smoke
snow
stalactites
stalagmites
straw

sun
tornado
tree

tree stump
tulip
tunnel entrance
volcano
waterfall
wave

web
wildflowers
willow tree
wind

wood

2¢

vehicles

Vehicles

Arab dhow
armored horse
camel

canoe
carriage

cart

chariot
Chinese junk
clipper ship
covered wagon
dog sled
double canoe
elephant
flying carpet
galleon

goat cart

hay wagon
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Category

Name

Objects Available

litter

llama
outrigger canoe
ox cart
peddler’s cart
pinto

pumpkin coach
raft

reed boat
rickshaw

royal coach
sleigh

sunken ship
travois

Viking ship
wagon

wheel barrow
wing

Shelter

adobe house
arch

barn

barred door
barred window
blacksmith shop
brick house
cabin

castle

cottage

desert tent
door
drawbridge
gingerbread hut
grass hut
hobbit hole
hogan

hollow tree
igloo
Indonesian hut
lighthouse

mill
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Category

Name

Objects Available

mine
mud hut

mushroom house

pagoda
palace
pueblo
pyramid
shack
sinister castle
small bridge
stable

stick house
stilted hut
stone bridge
stone cottage
straw house
tipi

tower

village
wigwam
windmill
window
wooden bridge

el

things

Things

Asian hat
bag

bag of gold
bag of grain
banner
banquet table
barrel

basket

bed

bow and arrow
bowl

bread

brick wall
broom
bucket

butter churn
cage
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Category Name Objects Available
cake

candle
catapult
cauldron
chair

circle

clay pot
club

cradle
cIown
crystal ball
cup
cupboard
desert headgear
drum
drumstick
eyes
feathered hat
fence
fireplace
flowered hat
fountain
fruit basket
gems

genie bottle
goblet

harp

hat

hour glass
iron gate
jug

kettle

key

ladder

large bucket
line

loom

lyre

magic lamp
mirror

oar
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Category Name Objects Available

oil lamp
peace pipe
picket fence
picnic basket
9) 1]

plate

plow
porthole

pot of gold
rake
rectangle
rocking chair
round basket
ng
SCarecrow
scarf

scepter
scroll

shield

shoe

shovel
skeleton
small basket
sombrero
spinning wheel
square

stick

stone wall
stool

sword

table
tablecloth
tea kettle
teapot

tears

throne
treasure chest
triangle
trumpet
turban

ymbrella
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Category Name Objects Available

wallpaper
wand

war bonnet
watering can
water jug
well

wooden gate
wood planks
yarn
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You can prepare a data disk to save your stories before you launch
Storybook Weaver: World of Make-Believe. The procedure for
creating a data disk is very simple. Just follow the standard
procedure for starting up your Apple IIGS, using Storybook Weaver:
World of Make-Believe (see “Getting Started,” beginning on

page 7). When the desktop appears, instead of clicking on the
Storybook Weaver: World of Make-Believe icon, eject the Program
disk and insert an uninitialized 3.5" disk in the disk drive. The
program will inform you that this disk is unreadable and will give
you the opportunity to change your mind about initializing it. (This
is done to reduce the chances of accidentally erasing an important
or unlabeled data disk.) The prompt looks like this:

m 65708 daes not recognize the file system on
this disk (in device .APPLEDISK3.5A). Do you

want to initialize it?
Please name this disk:  |IEYSTIIT |

After you have given the disk a name, click on the Continue button.

Another dialog box appears. Click on the Initialize button. The
program then initializes the disk for use with the Apple IIGS. Once
this process is complete, you can eject the data disk, reinsert the
Program disk, and resume starting Storybook Weaver: World of
Make-Believe.

You can also create a Storybook Weaver: World of Make-Believe
data disk by inserting a blank, unformatted 5.25" disk in the Apple
5.25" Disk Drive. When the disk is in the drive, double-click on the
drive icon. You will then be prompted to initialize the disk and
follow the same procedure as creating a 3.5" data disk.

Creating and Using
a Data Disk
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Organizing Your
Data Disk

Key Combination
Command
Equivalents

A limit of 51 files can be saved in the disk or volume directory. On
a 3.5" data disk, the maximum number of files may be reached
before the data disk runs out of space. If you tried to save to a disk
with the maximum number of files, you would see the following

alert:

Unable to save because
volume directory is full.

To prevent this, you should create folders that can hold an unlimited
number of files. Then, save your documents to one of the folders
you have created. Folders can also help organize documents by
purpose, assignment, author, or type.

3-A
3-B
a-C
G-F
3-G
a3-1
3-N
3-0
A3-p
3-Q
3-R
3-v
3-w
3-X
3-z
a3-?

Select All
Send to Back
Copy

Bring to Front
Go To Page
Ideal Size
New

Open

Print

Quit

Restore Color
Paste

Close

Cut

Undo

Help
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